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Filing a health insurance claim form is a key step to getting reimbursed for medical expenses.This document helps your insurer process payments for services like doctor visits or hospital stays.This article explains the health insurance claim form, how to fill it out, and tips for success in simple, easy language.A health insurance claim form is a
document you submit to your insurance company to request payment for medical services. It includes details about the treatment, provider, and costs. Most insurers provide their own forms, available online or through customer service.The form ensures your insurer has the information needed to process your claim. Its used when providers dont bill
insurance directly or for out-of-network care. Completing it accurately prevents delays or denials.You need a health insurance claim form when your provider doesnt submit claims directly. This often happens with out-of-network doctors or services like dental care. Its also used for reimbursement if you pay upfront for covered services.Some plans
require forms for specific treatments, like physical therapy. Check your policy to know when a form is needed. Contact your insurer if youre unsure about the process.Different insurers and plans use specific claim forms. Common types include medical, dental, and vision claim forms. Medicare and Medicaid have their own standardized forms, like the
CMS-1500 for medical claims.Some insurers offer a universal health insurance claim form, such as the CMS-1500, accepted by many providers. Always use the form specified by your insurer to avoid errors. Forms are typically downloadable from the insurers website.Filling out a health insurance claim form requires specific details. Youll need
personal information, like your name, policy number, and contact details. Medical details include the providers name, date of service, and diagnosis codes.Include billing information, such as the total cost and itemized receipts. Accurate details ensure faster processing. Gather all documents before starting to streamline the process.Completing a
health insurance claim form is straightforward if you follow these steps. Each step ensures your claim is accurate and complete. Heres how to do it:Gather Documents: Collect receipts, bills, and medical records.Download the Form: Get the correct form from your insurers website.Fill in Details: Enter personal, medical, and billing information
accurately.Submit the Form: Send it by mail, online, or fax as instructed.A health insurance claim form has several key sections. The patient section includes your name, address, and policy number. The provider section lists the doctor or facilitys details, like their tax ID and contact information.The service section describes the treatment, including
dates and procedure codes. The billing section covers costs and any payments you made. Double-check each section to avoid mistakes.Once completed, submit the health insurance claim form to your insurer. Most companies accept submissions online through a member portal, by mail, or via fax. Online submission is often the fastest and most
convenient option.Include all required documents, like itemized bills and receipts. Keep copies of everything for your records. Confirm the submission method with your insurer to ensure its received.After submitting a health insurance claim form, processing times vary. Most insurers take 7 to 30 days to review and approve claims. Complex cases or
missing information can cause delays.You can track your claims status through the insurers online portal or by calling customer service. Prompt submission and complete documentation speed up the process. Follow up if you dont hear back within a month.Claims can be denied for various reasons, often related to errors or policy limits. Incomplete or
incorrect forms are a frequent cause. Missing receipts or incorrect codes also lead to rejections.Other reasons include non-covered services or out-of-network providers. Review your plans coverage and double-check the form to reduce denial risks. If denied, you can appeal with additional documentation.Filing a health insurance claim form correctly
increases your chances of approval. These tips help you avoid common pitfalls:Verify coverage for services before treatment.Use the exact form required by your insurer.Include all receipts and medical records.Submit within your plans deadline, often 90 days to a year.Different insurers have unique claim forms, though many use the CMS-1500 for
medical claims. The table below compares features of claim forms from three major insurers.InsurerForm TypeSubmission MethodsKey FeaturesBest ForBlue Cross Blue ShieldCMS-15000nline, mail, faxClear instructions, universal useOut-of-network medical claimsUnitedHealthcareCustom formOnline, mailMember portal integrationIn-network and
reimbursement claimsAetnaCMS-15000nline, mail, faxDetailed billing sectionDental, vision, and medical claimsThis table shows that CMS-1500 is widely used, but submission methods vary. Check your insurers website for the correct form and process.If your health insurance claim form is denied, you can appeal. Contact your insurer to understand
the denial reason, often listed in a denial letter. Gather additional documents, like medical records or a doctors note, to support your case.Submit the appeal within the deadline, usually 180 days, via the insurers portal or mail. Most plans allow multiple appeal levels. Persistence and clear documentation can overturn denials.Many insurers offer
online portals or apps for submitting health insurance claim forms. These platforms let you upload forms and documents securely. Some, like UnitedHealthcares app, provide claim tracking and payment updates.Digital tools simplify the process and reduce paperwork. Ensure you have a stable internet connection when uploading. Always confirm
receipt of your submission to avoid delays.Submitting a health insurance claim form accurately ensures you get reimbursed for covered services. Errors or missing information can lead to denials, delaying payments. Correct forms also reduce stress and financial strain from medical bills.Proper filing maximizes your plans benefits, saving you money.
Its a critical step in managing healthcare costs effectively. Taking time to get it right pays off.A health insurance claim form is essential for getting reimbursed for medical expenses, especially for out-of-network care or upfront payments. It requires details like patient information, provider details, and billing records.Submitting accurate forms via
online portals, mail, or fax ensures timely processing, typically within 7 to 30 days. By following your insurers guidelines, using tips like verifying coverage, and appealing denials if needed, you can navigate the process smoothly.Understanding and completing the health insurance claim form correctly helps you maximize your benefits and avoid
financial stress.A health insurance claim form is a document used to request reimbursement for medical expenses. It includes patient, provider, and billing details. Insurers provide specific forms, often available online.File a form for out-of-network care, services not billed directly, or upfront payments. Its also needed for specific treatments like dental
care. Check your plan for requirements.Most claims are processed in 7 to 30 days. Missing information can cause delays. Track your claims status via your insurers portal or customer service.Appeal the denial by submitting additional documents within the deadline, usually 180 days. Contact your insurer for the denial reason. Appeals can often
overturn denials with proper evidence.Many insurers offer online portals or apps for submitting claim forms. Upload forms and documents securely. Confirm receipt to ensure processing starts promptly.Healthcare.govCenters for Medicare & Medicaid Services When you or a loved one gets sick and needs health care, the last thing you want to think
about is filing an insurance claim. Health care can be complicated and full of jargonand theres often a huge amount of paperwork involved. If you dont dot your Is and cross your Ts, your insurance company can reject your claim. So, if you do find out you have to file a claim, how do you know if youre doing it correctly? Okay. Take a deep breath. Lets
walk through how to file an insurance claim form. How to File an Insurance Claim Form When you get medical care, you usually dont even see the claim. For example, if you have a sinus infection, you call your doctor, set up an appointment, have a quick exam, and maybe get a prescription for antibiotics. You pay your co-pay and they send you on
your way. The doctors billing department fills out a health insurance claim formusually a CMS-1500, also known as a pink sheet because of its distinctive color.1 They send it to your insurance company and its the last you hear of it. Well, thats the way it usually works. Depending on your health insurance plan and the kind of services you receive, you
may have to file an insurance claim form yourself. Heres a scenario: You and your family head to another state for a long ski weekend. One day, while cruising down the slopes, you hit that mogul going just a little too fast. You wipe out and break your leg. One quick ambulance ride to the emergency room later, you get an X-ray, a cast and a pair of
crutches. Depending on your health insurance plan and the kind of services you receive, you may have to file an insurance claim form yourself. Oh, and you also get a giant bill because the small-town hospital is out of your network and wont work with the insurance you have from three states away. Youre going to need to file a health insurance claim
form. Heres what you need: 1. Claim Form Your insurance company should have a health insurance claim form on their website. This will be a special claim form specific to your health plan. Theyll probably have a way to file the claim online, which is nice. But you should also be prepared to print the claim form and mail it in. Here are some things you
may need to include on the form: Your insurance policy number, member number or group plan number The name of the patient receiving medical treatment (you, your spouse, your child or anyone covered under your plan) Whether or not you have dual coverage or coinsurance The reason for the treatment (like an injury, illness or preventive care) If
you get into an accident at work and workers compensation covers it, you may need to fill out lots of special paperwork and go through a different insurance company than your normal health insurance company. Youll want to talk to your Human Resources representative or consult an attorney who specializes in workers compensation. This is also
true if you get hurt in an auto accident or because of someone elses negligence (like if you slip and fall on a wet surface inside of a business). These claims can get really complicated, and its good to have someone in your corner. 2. An Itemized Bill and Receipts This is important. You absolutely must get an itemized bill from your provider. It should
detail every service your doctor provided and include things like: Lab tests like blood work or urine tests Radiology exams like X-rays, MRIs and CT scans Cardiovascular tests like EKGs and echocardiograms Durable medical equipment like crutches or braces In other words: If the doctor bills for it, you need to include it in the list. Each item should
be on a separate line and should include the ICD-10 code (more on this below) for each procedure. 3. Copies of Everything Make a copy of every single document you receive and put it into a file specifically marked for your claim. Youll want to keep everything in one place so you can easily find anything you may need later. Insurance claim forms
sometimes get denied or lost, and theyre subject to all kinds of shenanigans. So disputes can happen. Being able to quickly and easily refer to your paperwork is a lifesaver. Once you have everything organized, its time to file the claim. Most of the time, you can do this online. But sometimes you may have to submit a claim form by mail. Contact your
insurance company. They should be able to walk you through the submission process. Make a copy of every single document you receive and put it into a file specifically marked for your claim. Youll want to keep everything in one place so you can easily find anything you may need later. Insurance claim forms sometimes get denied or lost. What to Do
if Your Claim Is Denied Okay, youve done everything right. Youve dotted your Is and crossed your Ts, youve sent everything in, and youve spoken with customer service. But a couple of weeks go by, and you get an Explanation of Benefits form that says your claim has been denied. Or maybe your insurance company approved part of the claim and paid
some of it, but they denied another part. Remember to breathe! Its okay. Dont panic. This happens a lot more often than youd think. There are lots of reasons insurance companies deny claims. These could include: Coding errors: Every diagnosis that a medical provider determines you need has whats called an ICD-10 code (short for International
Statistical Classification of Diseases and Related Health Problems, 10th Revision). The ICD-10 code is used for billing and tracking diseases and treatments.2 If a provider bills for a treatment or procedure that isnt linked to a particular diagnosis, its going to be rejected. Failure to get prior authorization: Some treatmentsusually big, expensive things
like surgeries or certain diagnostic studies like MRIs or colonoscopiesrequire the provider to get authorization from your insurance company before theyre performed. A lot of times, this is impractical or impossibleusually because its an urgent situation and theres no time to get authorization. You can always appeal these. Missing or incorrect
information: This is another common one, and it usually involves missing paperwork like a medical report. Thats why its important to collect all relevant data. Treatment is deemed medically unnecessary or experimental: Insurance companies may deny a claim because they dont think the treatment is actually needed to make a patient well. Surgeries
to correct deformities such as a deviated septum or varicose veins are common procedures that might be denied. A claims adjustor may look at the claim and deny it as a cosmetic procedure which isnt typically covered by insurance. Treatment is not covered by your plan: Read your policy carefully. Depending on your policy and level of coverage,
some treatments may just not be covered. So, what do you do if a claim is denied? Theres always an appeals process. Just make sure you have all your records (including documentation of any phone calls) in order. If youre documenting a phone call, Include the date, time and a reference number (if available). Always get the name of the person you
talked to. If your insurance company denies your claim because its deemed to be not medically necessary, youll most likely need to involve your health care provider. Most insurance companies have a medical professional (like a doctor or a registered nurse) who determines what is necessary and what isnt. Your doctor can set up whats called a peer-
to-peer review. Sometimes called a doc-to-doc, a peer-to-peer review involves your doctor speaking with the insurance companys doctor to explain the medical necessity of the treatment or procedure. Always ask for one of these if your claim is denied for this reason. Youll also want to make sure you keep track of the date. Most insurance companies
have a timeline for filing appeals. If your appeal gets there too late, they can refuse to consider it. Health insurance is complicated and can drive just about anyone up the wall. If youre shopping for health insurance or you dont like your current policy and youre looking for something else, we have some next steps for you to consider as you go deeper
into your search for awesome coverage. Sign up to receive helpful guidance and tools. Filing a health insurance reimbursement form can feel daunting, especially when dealing with medical bills. However, it becomes much easier to navigate with a clear understanding of the process. Whether youre covered under the best health insurance policy or
exploring different medical insurance plans, knowing how to accurately fill out the reimbursement form is essential. This guide walks you through 10 simple steps to help you file your health insurance claim seamlessly.Filling out a health insurance reimbursement form can seem daunting, but following a step-by-step guide can simplify the process.
First, gather all necessary documents, including receipts, medical bills, and your policy details. Next, carefully fill in your personal information, including your policy number and the dates of treatment. Ensure you provide clear details about the services received, the amount paid, and any supporting medical documents.Double-check the form for
accuracy before submission to avoid delays. Keep a copy of all submitted materials for your records. If youre traveling abroad, why is travel insurance necessary for your trip? It provides coverage for unexpected medical expenses, ensuring youre financially protected in case of illness or injury, and helps streamline the reimbursement process for any
medical claims you may need to file.Before you begin filling out a reimbursement form, its crucial to understand the specifics of your medical insurance plan. Each plan has different coverage limits, exclusions, and procedures. Check what your plan covers, such as hospitalisation, diagnostic tests, or outpatient care. Familiarise yourself with the
deductibles, co-payments, and documentation required. This basic understanding of your health insurance planning will help you avoid errors and surprises when submitting your claim.The next step is collecting all the documents related to the medical expenses you claim. Heres a checklist of what youll likely need:Itemised medical billsHospital
discharge summary (if applicable)Doctors prescriptionsDiagnostic test reportsPharmacy billsPayment receiptsMake sure that each document is legible and properly organised. Insurers typically require these documents to verify your claim; incomplete paperwork can lead to delays or even rejection.Most medical insurance plans provide a
reimbursement form you can download from the insurers website. You may also receive a hard copy if you visit their office. Ensure you are using the most up-to-date version of the form. Each insurer may have slightly different formats, so ensure youre filling out the correct one for the type of treatment or expenses you claim.The first section of the
form usually asks for your basic personal and policy information. This will include:Your full name (as on the insurance policy)Policy numberContact details (phone, email, address)Bank account details (for receiving the reimbursement)Ensure that these details are accurate and match whats on your best health insurance policy. Incorrect information
here can lead to delays in processing your claim.If the patient is someone other than the policyholder (such as a spouse or child), you must also enter their details. Information typically required includes:Patients nameRelationship to policyholderDate of birthDiagnosisHospital or doctors detailsAccurately filling out these fields is essential, as
inconsistencies can lead to the rejection of your claim.One of the most important sections of the reimbursement form is where you itemise your medical expenses. This is where you list all the costs you are claiming, such as:Doctors consultation feesHospital room chargesDiagnostic test costsPharmacy expensesSurgical or procedural feesEnsure that
the amounts you list correspond exactly with the receipts and bills. Mismatches can cause the insurer to question your claim and delay reimbursement. For those involved in health insurance planning, keeping copies of bills and organising them as you incur them is always a good idea, making this step easier.Once the form is filled out, attach the
supporting documents mentioned earlier. Always check if your medical insurance plan requires original copies or if scanned documents or photocopies are acceptable. Generally, insurers ask for:Original medical bills and receiptsDiagnostic and test reportsHospital discharge summariesDoctors prescriptionsMake sure everything is attached in the
correct order, as per the forms instructions. This will make the processing of your claim smoother and faster.Before submitting your form, review it thoroughly. Double-check the following:All personal and policy information is accurateMedical expenses are itemised correctlyNo supporting documents are missingSignatures are in the appropriate
placesThis step may seem basic, but simple mistakes delay or reject many claims. Before submission, its also wise to make copies of everything for your own records.Now that the form is complete and reviewed, its time to submit it. You can usually submit the form through various channels:Online through the insurers website or mobile appBy mailing
it to the insurance companys officeln person at one of their branchesSubmitting the form online is often the quickest and easiest way, especially with the growing focus on digital solutions in health insurance planning. Many insurers offer claim-tracking features, allowing you to monitor the status of your claim online.Once youve submitted your claim,
the final step is to track its status. Most insurers will provide a claim reference number that you can use to monitor your claim online or through customer service. Some best health insurance companies offer email or SMS updates to keep you informed at every stage of the process.If your claim is delayed or rejected, dont panic. Review the reasons
for any rejections, which are often due to missing or incorrect information. You can usually resubmit the form with the corrected details.Filling out a health insurance reimbursement form might seem like a complex process, but by following these 10 steps, you can make it a manageable and smooth experience. From understanding your medical
insurance plan to gathering the right documents and double-checking your information, each step plays a crucial role in ensuring your claim gets processed quickly.Remember, health insurance planning is about more than just selecting the right policy. It also involves understanding how to navigate the claims process efficiently. If youre looking for
the best health insurance policy then you have come to the right place, Niva Bupa the best health insurance company in India can curate a plan that fulfils all your needs and also offers additional features. Filling out a health insurance claim form correctly is essential to ensuring your medical expenses are reimbursed without delays. Mistakes or
missing details can lead to rejections, requiring additional time and effort to resolve. Understanding the process helps avoid errors and speeds up approval. To complete a claim form properly, you need accurate policy information, detailed medical records, and proper documentation. Following submission guidelines and deadlines is also crucial.
Required Policy InformationAccuracy starts with correctly entering your policy details. Every claim requires your policy number, which uniquely identifies your coverage. This number is typically found on your insurance card or policy documents. The policyholders namewhether yours or a family members under a group planmust match exactly as it
appears in the insurers records to prevent delays. Insurers also need details about your coverage type. Policies vary from employer-sponsored plans to individual marketplace policies, each with different claim processing rules. Some, like HMOs, require referrals or pre-authorizations, while PPOs offer more flexibility. Including the correct group
number, if applicable, helps insurers determine whether the claim falls under an employer-sponsored or individual policy, which affects reimbursement rates and network restrictions. If you have multiple health insurance policies, you must complete the coordination of benefits (COB) section. Insurers use COB to determine which policy pays first and
how much the secondary insurer covers. Failing to disclose additional coverage can lead to claim denials or delays. Understanding your deductible, co-pay, or co-insurance ensures you know what portion of the bill you are responsible for before submitting the claim. Essential Medical DetailsProviding accurate medical information is necessary for
proper processing and reimbursement. Insurers require details about the diagnosis and treatment to assess whether the claim aligns with your coverage. The diagnosis code (ICD-10) identifies the medical condition, while the procedure code (CPT) specifies the services received. These codes must match the medical records submitted; discrepancies
can result in rejections or requests for more documentation. The date of service is also crucial, as it determines whether the claim falls within the policys active coverage period. If multiple services were provided on different dates, each must be listed separately. The treating physician or facilitys name and contact details should be included, as
insurers may verify treatment before approving payment. Supporting documentation is often required, especially for complex procedures, hospitalizations, or ongoing treatments. This may include itemized bills, medical necessity letters, or test results. For inpatient stays, insurers may request discharge summaries. Missing or incomplete
documentation can delay processing, as insurers may request additional records. Disclosure ObligationsHealth insurance claim forms require full and truthful disclosure to ensure proper processing. Insurers use the provided details to determine claim validity, assess eligibility, and calculate reimbursement. Any omission or misrepresentation,
whether intentional or accidental, can cause delays, denials, or further investigation. One key area is pre-existing conditions. While many policies now cover them due to regulatory changes, some insurers may impose waiting periods or require documentation to confirm the condition was not misrepresented at enrollment. Claim forms also ask about
the circumstances surrounding treatment, such as whether an illness or injury resulted from an accident, workplace incident, or third-party liability. If another party is responsible for medical costssuch as in an auto accident or workers compensation caseinsurers need to coordinate benefits. Failing to disclose this can lead to complications. Financial
disclosures also play a role. Some policies have income-based eligibility criteria, particularly for government-subsidized plans, and claimants may need to confirm financial status when submitting claims. Additionally, if a policyholder has received payments for the same expenses from another source, such as a settlement, insurers may require
disclosure to prevent duplicate payments. Claim Form SignaturesSigning a health insurance claim form is a legal attestation that the provided information is accurate and complete. Your signature certifies that the listed medical services were received and that no false details were included. It also authorizes the insurer to verify the claim with
medical providers. Without a signature, the claim is considered incomplete and cannot be processed. Most claim forms include multiple signature fields. The policyholder or patient signs to confirm accuracy, while the healthcare provider may need to sign separately to verify that services were rendered. Some forms also include an assignment of
benefits (AOB) authorization, allowing the insurer to pay the provider directly instead of reimbursing the patient. This simplifies payment but may limit the patients ability to dispute charges later. Potential Rejection FactorsErrors or omissions can lead to claim rejections, requiring resubmission. One common reason is missing or incorrect
information, such as an inaccurate policy number, misspelled patient name, or incomplete provider address. Even minor discrepancies can cause delays. If the claim lacks necessary supporting documentationsuch as an itemized bill or proof of medical necessitythe insurer may deny it until the required paperwork is provided. Claims for treatments not
covered under the policy are another frequent reason for denial. Each health insurance plan has specific exclusions, including experimental procedures, elective treatments, or services deemed medically unnecessary. Claims that exceed policy limits or are submitted after the allowable filing period may also be rejected. Double-checking all entries
before submission can help prevent denials. Filing TimelinesStrict deadlines govern claim submission, and missing them can result in automatic denial. Most insurers require claims to be filed within 90 days to one year from the date of service. Some policies allow extensions for extenuating circumstances, such as hospitalization or provider billing
delays, but these typically require formal requests and documentation. Timeliness also affects reimbursement. Some insurers apply reduced payments to late submissions, even if approved. Additionally, many health plans operate on an annual benefits cycle, so claims submitted too late may fall outside the coverage period. To avoid issues,
policyholders should confirm filing deadlines and submit claims as soon as possible. Keeping digital or physical copies of submitted forms and confirmation receipts provides proof of timely filing in case of disputes. Submission ChannelsHealth insurance claims can be submitted through multiple channels, and choosing the right method impacts
processing speed and accuracy. Most insurers offer electronic submission, which is often the fastest option. Many healthcare providers file claims electronically on behalf of patients, reducing errors and ensuring compliance. When submitting electronically, policyholders should ensure the format follows the insurers specifications, as incorrect file
types or missing fields can cause delays. For manual submissions, paper forms must be completed legibly and sent to the correct address listed in the policy documents. Some insurers require original receipts or physician statements, which must be included to avoid delays. Mailing claims via certified mail or using an online tracking service provides
proof of submission. Some insurers also offer mobile app submissions, allowing policyholders to upload documents directly from their smartphones for quicker processing. Disputed ClaimsIf a health insurance claim is denied or underpaid, policyholders have the right to dispute the decision. The first step is reviewing the explanation of benefits (EOB)
statement, which outlines the reason for denial or reduced reimbursement. Common denial reasons include coding errors, insufficient documentation, or claims deemed outside of coverage. If the issue stems from incorrect billing codes, patients can request their provider to submit a corrected claim. If the denial seems unjustified, policyholders can
file an appeal. Most insurers have a formal appeals process, requiring a written request along with supporting documentation, such as medical records or physician letters. Appeals must be filed within a specified timeframe, often 30 to 180 days from the denial notice. If the insurer upholds the denial, policyholders may escalate the dispute to an
external review through state insurance regulators or independent third-party reviewers. Keeping detailed records of all communications and submissions strengthens an appeal and improves the chances of a favorable outcome. Share copy and redistribute the material in any medium or format for any purpose, even commercially. Adapt remix,
transform, and build upon the material for any purpose, even commercially. The licensor cannot revoke these freedoms as long as you follow the license terms. Attribution You must give appropriate credit , provide a link to the license, and indicate if changes were made . You may do so in any reasonable manner, but not in any way that suggests the
licensor endorses you or your use. ShareAlike If you remix, transform, or build upon the material, you must distribute your contributions under the same license as the original. No additional restrictions You may not apply legal terms or technological measures that legally restrict others from doing anything the license permits. You do not have to
comply with the license for elements of the material in the public domain or where your use is permitted by an applicable exception or limitation . No warranties are given. The license may not give you all of the permissions necessary for your intended use. For example, other rights such as publicity, privacy, or moral rights may limit how you use the
material. Filing a health insurance claim means you're requesting reimbursement or direct payment for medical services that you've already received. The way to obtain benefits or payment is by submitting a claim via a specific form or request. There are two ways to submit your health insurance claim. The easiest way to submit a claim is to have
your health services provider do it for you, but they can't do so if they're not in the network. You may want to coordinate your benefits and submit two claims, one to your own insurance company and one to your spouse's insurer, if you're covered on two plans. You must submit itemized receipts for the health care you received. You may be able to file
your claim online, which can speed up payment. The first way to file a health insurance claim (and the most convenient) is when your medical services provider can submit the claim directly to the insurance company on your behalf. They can do this electronically through the network. Your other option is to complete the claim form yourself and send
the paperwork to the insurance company yourself. This can be necessary if your health service provider is not in the network for your health plan or can't file it on your behalf. You may have coverage under one health insurance plan and under your spouse's plan as well. You may be able to get more compensation by coordinating these benefits, using
the two plans and filing two claims. It used to be that you had to submit health insurance claims through the mail, but many companies andmedical benefit plansoffer a few different options. They can depend on the health insurance company. When you go to the doctor or other medical provider and are told that you have to submit your insurance
claim form, it means that the doctor or facility doesn't ask thehealth insurance companyto pay for your bill, and you must do it yourself. You'll have to take certain steps to submit your insurance claim form. First, you must understand your medical bill. You'll also need some basic information to fill out the form. The claim form should be fairly self-
explanatory to fill out. It will ask things like:Your insurance policy number, group plan number, or member numberWho received the services (for example if it was the primary insured or a dependent like a child, spouse, ordomestic partner)If there is coinsurance ordual coverageWhat was the visit for (accident,worker's compensation), etc. Ask your
doctor for an itemized bill that lists every service that was provided and gives the cost of each of these services. Make sure any medications or drugs that are provided during treatment are listed with itemized costs. Your health insurance company will require that you attach the original itemized bills to the claim form. Contact your insurance
company to obtain a health insurance claim form or download a copy from their website. The form will also give you additional instructions about what other information the company might need from your doctor or health care facility. It's best to read through the form before beginning so you can gather any and all information necessary. Don't forget
to make copies of everything after you have your claim form filled out and your itemized bills from your doctor. This will eliminate any errors that may be made in the claim process and make it easier for you to refile your health insurance claim if it gets lost. You might also want to check the billing codes for medical errors and contact your health
provider if you need clarification. This step will avoid having your health insurance denied for incorrect information. Call your health insurance company and tell them you are about to send in your health insurance claim form. Review all the paperwork you have with them and ask if there's anything else you need. Ask how long you should expect to
wait for your claim to be paid and mark that date on your calendar. Send the claim form to yourinsurance company when you're sure everything is in order. The address should be on the claim form. Keep an eye out on your calendar for the claim date that you marked and contact your insurance company if you don't receive your claim within the
timeframe given to you. Check your health insurance company's website before you start filling in the paperwork and heading to the post office, Many insurance companies offer the possibility to log onto your health and medical benefits plan online. You can ask your employer if your health plan offers this option or contact your health plan insurer
directly if your plan isn't through an employer. There will usually be a place where you can log on if you go to your insurance company's website. Call them and have them help you set it up if necessary. You may also be able to fill in the information online and submit at least part of the claim via your health insurance company website. You might be
able to start the claim and just mail in the supplementary documents with the associated reference number if they don't offer full online submission. The benefit of submitting claims online is that the payment for your claim may be significantly faster, as soon as 24 hours in some cases.Getting your payment processed as fast as possible is worth going
through the effort of setting up an account to manage your services online. There's also a good chance that you'll immediately see what portion of your claim is covered,what your coinsurance clause is, and what deductible applies. Setting up an account to access your health insurance benefits and claims online will help you be better prepared
tounderstand the related health insurance out-of-pocket expenses, and what kind of refund or payment your benefits plan will pay. Ahealth insurance providermay not offer online submission or may limit online forms to specific services. You may have to print a claim form in this case, fill in all the details, and submit it via the mail. The time it takes to
process a claim can vary depending on the company, but it should take two to four weeks on average. Some states have laws that require them to be processed in 30 or 45 days. Your insurance company will have an appeals process you can use to request that it revisit your claim. It might have been denied in error, or more information may be needed.
Health insurance claim reimbursement isn't taxable in most cases. It doesn't have to be claimed on your tax return. But you should always check with your tax advisor about your personal situation because some health care costs are tax deductible. Thanks for your feedback! Jump to: Box #24a-#24jBoxes #25 through #33bBox Number: 1 - Insurance
NameWhere this populates from: Billing Info > Billing Preferences > Insurance TypeDescription: Where the type of health insurance coverage applicable to this claim is selected. There are seven plan types to select from, by checking the appropriate box. Only one plan type is allowed to be selected.Box Number: 1a - Insureds ID NumberWhere this
populates from: Patient File > Insurance tab > Card Info, ID on Card (patient can fill this out during onboarding if you are accepting insurance info). Description: Where the insured's ID number is entered as shown on their ID card for the payer to which the claim is being submitted.Box Number: 2 - Patients NameWhere this populates from: Personal
tab of Patient FileDescription: Where the patient's full name is entered as Last Name, First Name, Middle Initial, separated by commas.Box Number: 3 - Patients Birthdate and SexWhere this populates from: Personal tab of Patient FileDescription: Where the patient's 8-digit birth date is entered in the format MMDDYYYY. As well, the appropriate box
should be marked indicating the sex (gender) of the patient. Only one box can be marked.Box Number: 4 - Insureds NameWhere this populates from: Personal tab of Patient File OR if covered under someone else, Patient File > Insurance Tab > Card Info > ID on Card (patient can fill this out during onboarding if you are accepting insurance info).
Description: Where the insured's full name is entered as Last Name, First Name, Middle Initial, separated by commas.Box Number: 5 - Patients AddressWhere this populates from: Personal tab of Patient FileDescription: Where the patient's address information is entered. This is the patient's permanent residence. The first line is for the street
address. The second line is for the city and state. The third line is for the zip code and phone number.Box Number: 6 - Patients relationship to InsuredWhere this populates from: Insurance tab of the Patient File (If "Covered under someone else's insurance plan?" is switched to Yes OR patient can fill out during onboarding).Description: Where the
patient's relationship to the insured is entered. Only one box can be marked.Box Number: 7 - Insured AddressWhere this populates from: Personal tab of Patient File OR Patient File > Insurance Tab > Insured under someone else fields.Description: Where the patient's address information is entered. This is the patient's permanent residence. The first
line is for the street address. The second line is for the city and state. The third line is for the zip code and phone number.Box Number: 8 - Reserved for NUCC UseWhere this populates from: can not be modified within Unified PracticeDescription: Reserved field. It was previously used to report Patient Status. Patient Status no longer exists, so this
field has been eliminated.Box Number: 9 - Other Insureds NameWhere this populates from: Insurance tab must have Primary/Secondary/other insurance info filled out. Then in Billing Info > Billing Preferences, select Primary and Secondary insurances from the drop-down boxes.Description: Indicates that there is a holder of another policy that may
cover the patient. The insured's name is entered as Last Name, First Name, Middle Initial, separated by commas. If Box 11d is marked, complete boxes 9, 9a, and 9d, otherwise leave blank.Box Number: 9a - Other Insured's Policy or Group NumberWhere this populates from: Insurance tab must have Primary/Secondary/other insurance info filled out.
Then in Billing Info > Billing Preferences, select Primary and Secondary insurances from the drop-down boxes.Description: The other insured's policy or group number as it appears on the insured's health care identification card for secondary insurance. If Box 11d is marked, complete boxes 9, 9a, and 9d, otherwise leave blank.Box Number: 9b -
Reserved for NUCC UseWhere this populates from: can not be modified within Unified PracticeDescription: Box 9b is now a reserved field. It was previously used to report Other Insured's Date of Birth, Sex. Other Insured's Date of Birth, Sex no longer exists, so this field has been eliminated.Box Number: 9c - Reserved for NUCC UseWhere this
populates from: can not be modified within Unified PracticeDescription: Box 9c is now a reserved field. It was previously used to report Employers Name or School Name. Employers Name or School Name no longer exists, so this field has been eliminated.Box Number: 9d - Insurance Plan Name or Program NameWhere this populates from: can not be
modified within Unified PracticeDescription: Box 9d is the name of the insurance plan or program of the other insured as indicated in Box 9. If Box 11d is marked, complete boxes 9, 9a, and 9d, otherwise leave blank.Box Number: 10 - Is Patient's Condition Related ToWhere this populates from: Billing Info > Billing Preferences > Is Patient's condition
related to (this carries over from treatment to treatment).Description: Indicate whether the patients illness or injury is related to employment, auto accident, or other accident. Only one box on each line can be marked. Any item marked YES indicates there may be other applicable insurance coverage that would be primary, such as automobile liability
insurance. Primary insurance information must then be shown in Box 11.Box Number: 10a - Employment Where this populates from: Employment (current or previous) would indicate that the condition is related to the patients job or workplace.Description: Indicate whether the patients illness or injury is related to employment, auto accident, or other
accident. Only one box on each line can be marked. Any item marked YESindicates there may be other applicable insurance coverage that would be primary, such as automobile liability insurance. Primary insurance information must then be shown in Box 11.Box Number: 10b - Auto AccidentWhere this populates from: Auto accident would indicate
that the condition is the result of an automobile accident. The state postal code where the accident occurred must be reported if YESis marked in 10b for Auto Accident.Description: Indicate whether the patients illness or injury is related to employment, auto accident, or other accident. Only one box on each line can be marked. Any item marked
YESindicates there may be other applicable insurance coverage that would be primary, such as automobile liability insurance. Primary insurance information must then be shown in Box 11.Box Number: 10c - Other AccidentWhere this populates from: Other accident would indicate that the condition is the result of any other type of
accident.Description: Indicate whether the patients illness or injury is related to employment, auto accident, or other accident. Only one box on each line can be marked. Any item marked YESindicates there may be other applicable insurance coverage that would be primary, such as automobile liability insurance. Primary insurance information must
then be shown in Box 11.Box Number: 10d - Reserved for Local UseWhere this populates from: can not be modified within Unified PracticeDescription: Used to identify additional information about the patients condition or the claim. When required by payers to provide the sub-set of Condition Codes approved by the NUCC, enter the Condition Code
in this field.Box Number: 11 - Insured Policy Group or FECA NumberWhere this populates from: Billing Info > Billing Preferences > select which company is being used as Primary for this visit.Description: The insured's policy or group number as it appears on the insured's health care identification card.Box Number: 11a - Insured Date of Birth and
SexWhere this populates from: Personal tab of Patient FileDescription: Where the insured's 8-digit date of birth in the format MMDDYYYY is entered and a box indicating the insured's gender is marked.Box Number: 11b - Other Claim ID (Designated by NUCC)Where this populates from: can not be modified within Unified PracticeDescription: The
other claim ID. Claim identifiers are designated by the NUCC.Box Number: 11c - Insurance Plan Name Or Program NameWhere this populates from: Insurance tab of Patient File by selecting the Insurance Plan (goes for all types).Description: The name of the insurance plan or program of the insured. Some payers require an identification number of
the primary insurer rather than the name in this field.Box Number: 11d - Is there another Health Benefit PlanWhere this populates from: Billing Info > Billing Preferences > Secondary InsuranceDescription: If Box 11d is marked, complete boxes 9, 9a, and 9d, otherwise leave blank. This specifies if there is another health benefit plan attached to this
claim. Mark the appropriate box (Yes or No). Only one box can be marked.Box Number: 12 - Patients or Authorized Persons SignatureWhere this populates from: Billing Info > Billing Preferences >Signature Date. If switched to Yes, you can enter the date. Otherwise, this is left blank.Description: Where the signature and date indicating authorization
to release any medical information needed to process and/or adjudicate the claim. This can be done by entering Signature on File, SOF or the actual signature.Box Number: 13 - Insureds or Authorized Persons SignatureWhere this populates from: This is automatically populated by Unified Practice with Signature on File.Description: Where the
signature indicating authorization of payment for medical benefits to the provider of service. This can be done by entering Signature on File, SOFor the actual signature.Box Number: 14 - Date of Current Illness, Injury, or PregnancyWhere this populates from: Billing Info > Billing Preferences > Onset DateDescription: Identifies the first date of onset
of illness, the actual date of injury, or the LMP for pregnancy. Enter the 6-digit (MMDDYY) or 8-digit (MMDDYYYY) date of the first date of the present illness, injury, or pregnancy. For pregnancy, use the date of the last menstrual period (LMP) as the first date. Enter the applicable qualifier to identify which date is being reported.Box Number: 15 -
Other DateWhere this populates from: Billing Info > Billing Preferences > Other DateDescription: Where another date related to the patients condition or treatment is entered. Enter the applicable qualifier to identify which date is being reported. 454 Initial Treatment, 304 Latest Visit or Consultation, 453 Acute Manifestation of a Chronic Condition,
439 Accident, 455 Last X-ray, 471 Prescription, 090 Report Start (Assumed Care Date), 091 Report End (Relinquished Care Date), 444 First Visit or Consultation.Box Number: 16 - Dates patient unable to work in current occupationWhere this populates from: can not be modified within Unified PracticeDescription: Where the time span the patient is,
or was, unable to work is entered if the patient is employed and is unable to work in their current occupation. A 6-digit (MMDDYY) or 8-digit (MMDDYYYY) date must be shown for the fromto dates that the patient is unable to work. An entry in this field may indicate employment-related insurance coverage.Box Number: 17 - Name of Referring
Provider or other SourceWhere this populates from: [1.] Patient File > Personal Tab > Edit > Referring Provider [2.] Billing Info > Billing Preferences > Fill in referring providers detailstoggle switched to YesDescription: Where the name of the referring provider, ordering provider, or supervising provider who referred, ordered or supervised the
service(s) or supply(ies) on the claim. The qualifier indicates the role of the provider being reported. Enter the name (First Name, Middle Initial, Last Name) followed by the credentials of the professional who referred or ordered the service(s) or supply(ies) on the claim. Enter the applicable qualifier to the left of the vertical dotted line to identify
which provider is being reported. DN Referring Provider, DK Ordering ProviderBox Number: 17aWhere this populates from: This field can not be populated from Unified PracticeBox Number: 17b - NPIWhere this populates from: Patient File > Personal Tab > Edit > Referring Provider > Add new provider > NPIDescription: Where the NPI number of
the referring, ordering, or supervising provider is entered. The NPI number refers to the HIPAA National Provider Identifier number.Box Number: 18 - Hospitalization dates related to current servicesWhere this populates from: can not be modified within Unified PracticeDescription: Where you would refer to an inpatient stay and indicates the
admission and discharge dates associated with the service(s) on the claim. Enter the inpatient 6-digit (MMDDYY) or 8-digit (MMDDYYYY) hospital admission date followed by the discharge date (if discharge has occurred). If not discharged, leave discharge date blank. This date is when a medical service is furnished as a result of, or subsequent to, a
related hospitalization.Box Number: 19 - Additional Claim InformationWhere this populates from: Billing Info > Billing Preferences, Additional Claim InformationDescription: Used to identify additional information about the patients condition or the claim. Please refer to the most current instructions from the public or private payer regarding the use
of this field. Some payers ask for certain identifiers in this field. If identifiers are reported in this field, enter the appropriate qualifiers describing the identifier.Box Number: 20 - Outside Lab, $ chargesWhere this populates from: Billing Info > Billing Preferences > Outside LabDescription: Used to indicate that services have been rendered by an
independent provider.Box Number: 21- Diagnostic or Nature of Illness or Injury (ICD Ind)Where this populates from: Billing Info > ICD codesDescription: Used to identify the applicable ICD indicator to specify which version of ICD codes are being reported. 9 ICD-90 ICD-10Box 21, Lines A through L, are used to indicate the sign, symptom, complaint,
or condition of the patient relating to the service(s) on the claim. Up to 12 ICD-9-CM or ICD-10-CM diagnosis codes can be entered.Box Number: 22 - Resubmission Code, Original Ref No.Where this populates from: Billing Info > Billing Preferences > Resubmission code (left), Original reference number (right) Description: Used to list the original
reference number for resubmitted/corrected claims. When resubmitting a claim, enter the appropriate bill frequency code left justified in the left-hand side of the field. 6 Corrected Claim7 Replacement of prior claim 8 Void/cancel of prior claimBox Number: 23 - Prior Authorization numberWhere this populates from: Patient File > Insurance tab >
Prior authorization turned on > Authorization #Description: Used to show the payer assigned number authorizing the service(s).Box Number: 24Description: Used to list the completed services for the claim. The six service lines in section 24 have been divided horizontally to accommodate submission of both the NPI and another/proprietary identifier
and to accommodate the submission of supplemental information to support the billed service. The top area of the six service lines is shaded and is the location for reporting supplemental information. It is not intended to allow the billing of 12 lines of service. The supplemental information is to be placed in the shaded section of 24A through 24G as
defined in each Item Number. Providers must verify requirements for this supplemental information with the payer.Box Number: 24a - Dates of ServiceWhere this populates from: Appointment DateDescription: Indicates the actual month, day, and year the service(s) was provided.Box Number: 24b - Place of serviceWhere this populates from:
Locations & Rooms > Edit Location > Facility Code Description: Used to identify the location where the service was rendered. Enter the appropriate two-digit code from the Place of Service Code list for each item used or service performed.Box Number: 24c - EMGWhere this populates from: can not be modified within Unified PracticeDescription:
Identifies if the service was an emergency. Check with payer to determine if this information (emergency indicator) is necessary. If required, enter Y for YES or leave blank if NO in the bottom, unshaded area of the field. The definition of emergency would be either defined by federal or state regulations or programs, payer contracts, or as defined in
5010A1.Box Number: 24d - Procedures, services, or suppliesWhere this populates from: Appointment bill, CPT codes -or- CPT Fee Schedule [on iPad]Description: Used to identify the medical services and procedures provided to the patient. Enter the CPT code(s) and modifier(s) (if applicable) from the appropriate code set in effect on the date of
service. This field accommodates the entry of up to four two-digit modifiers. The specific procedure code(s) must be shown without a narrative description.Box Number: 24e - Diagnostic pointerWhere this populates from: Appointment bill, CPT codes, ICD pointer -or- Chief Complaint & ICD [on iPad]Description: Used to indicate the line letter from Box
21 that relates to the reason the service(s) was performed. Enter the diagnosis code reference letter (pointer) as shown in Box 21 to relate the date of service and the procedures performed to the primary diagnosis. When multiple services are performed, the primary reference letter for each service should be listed first, other applicable services
should follow. The reference letter(s) should be A L or multiple letters as applicable. ICD-9-CM (or ICD-10-CM, once mandated) diagnosis codes must be entered in Box 21 only. Do not enter them in 24e.Box Number: 24f - ChargesWhere this populates from: Fee Schedule (or if changed, charge in billing info screen)Description: The total billed amount
for each service line. Enter the charge for each listed service, right justified in the dollar area of the field. Do not use commas when reporting dollar amounts. Negative dollar amounts are not allowed. Dollar signs should not be entered. Enter 00 in cents area if the amount is a whole number.Box Number: 24g - Days or UnitsWhere this populates from:



Appointment Billing InfoDescription: Used to indicate the number of days corresponding to the dates entered in 24A or units as defined in CPT coding manual(s). Enter the number of days or units. This field is most commonly used for multiple visits, units of supplies, anesthesia units or minutes, or oxygen volume. If only one service is performed, the
numeral 1 must be entered. Enter numbers left justified in the field. No leading zeros are required. If reporting a fraction of a unit, use the decimal point.Box Number: 24h - EPSDT Family PlanWhere this populates from: cannot be modified within Unified PracticeDescription: Box 24h is used to identify certain services that may be covered under some
state plans.Box Number: 24i - ID QualifierWhere this populates from: Clinic Staff > Details > Taxonomy Code OR Account > My Account > Taxonomy Code, if it is entered, 'ZZ' will appear in the grey area of column 24iDescription: Indicate the appropriate qualifier and identifying number in the shaded area.Box Number: 24j - Rendering Provider
ID#Where this populates from:Clinic Staff > Details > Practitioner NPI, if it is entered (even if the toggle Use this NPI.. is turned off)If Practitioner NPI is empty it takes the NPI configured in Clinic Settings >Billing InformationIf both are empty, the field remains emptyClinic Staff > Details > Taxonomy Code, if it is entered, it will appear in the grey
area of column 24jDescription: Indicates the individual performing/rendering the service.Box Number: 25 - Federal TAX ID numberWhere this populates from: Account > My Account > Personal Tax ID > switch Use this ID as the Tax ID for my Superbills and Claim forms for billing toggle to Yes.If Practitioner Tax ID is empty or Use this Tax ID..is
turned off then it takes the Tax ID configured in Billing InformationIf both are empty, the field remains emptyDescription: Indicates the unique identifier assigned by a federal or state agency. Enter the Federal Tax ID Number (employer ID number or SSN) of the Billing Provider identified in Box 33. This is the tax ID number intended to be used for
1099 reporting purposes. Enter an X in the appropriate box to indicate which number is being reported. Only one box can be marked.Box Number: 26 - Patient Account NumberWhere this populates from: cannot be modified within Unified PracticeDescription: Indicates the identifier assigned by the provider.Box Number: 27 - Accept Assignment?
Where this populates from: Billing Info > Billing Preferences > Accept AssignmentDescription: Indicates that the provider agrees to accept assignment under the terms of the payers program. Enter an X in the correct box. Only one box can be marked. Report Accept Assignment? for all payers.Box Number: 28 - Total ChargeWhere this populates
from: Service balance due in Billing InfoDescription: Indicates the total billed amount for all services entered in Box 24f (lines 16). Enter total charges for the services (i.e., total of all charges in 24F). Enter the number right justified in the dollar area of the field. Do not use commas when reporting dollar amounts. Negative dollar amounts are not
allowed. Dollar signs should not be entered. Enter 00 in cents area if the amount is a whole number.Box Number: 29 - Amount PaidWhere this populates from: Billing Info > Billing Preferences > switch Amount Paid - fill-in amount paid by patient for services to Yes and fill in the amount. This will auto-fill from payment received/applied.Description:
Indicates the payment received from the patient or other payers. Enter total amount the patient and/or other payers paid on the covered services only. Enter the number right justified in the dollar area of the field. Do not use commas when reporting dollar amounts. Negative dollar amounts are not allowed. Dollar signs should not be entered. Enter 00
in cents area if the amount is a whole number.Box Number: 30 - Balance DueWhere this populates from: Total charge minus balance due that is listed on the CMS-1500 form.Box Number: 31 - Signature of Physician or SupplierWhere this populates from: Name in My Account & the Date of Service - or - Clinic Settings then Clinic Staff and click Details
to the right to the Practitioner's name.The signature will reflect the name of the Practitioner assigned to the appointment - or - the last Practitioner to sign and lock the SOAP note.Description: Refers to the authorized or accountable person and the degree, credentials, or title. Enter the legal signature of the practitioner or supplier, signature of the
practitioner or supplier representative, Signature on File, or SOF. Enter either the 6-digit date (MM|DD|YY), 8-digit date (MM|DD|YYYY), or alphanumeric date (e.g., January 1, 2003) the form was signed.Box Number: 32 - Service Facility Location InformationWhere this populates from: Clinic Settings > Locations & Rooms > Edit LocationDescription:
Indicates the name and address of facility where services were rendered identifies the site where service(s) were provided. Enter the name, address, city, state, and ZIP code of the location where the services were rendered.Box Number: 32aWhere this populates from: Clinic Settings > Locations & Rooms > Edit Location > Service Facility NPIIf this
is not entered, 32a remains empty. Description: Indicates the HIPAA National Provider Identifier number. Enter the NPI number of the service facility location. Only report a Service Facility Location NPI when the NPI is different from the Billing Provider NPI.Box Number: 32bWhere this populates from: cannot be modified within Unified
PracticeDescription: Indicates the non-NPI ID number of the service facility as assigned by the payer for the facility. Enter the 2-digit qualifier identifying the non-NPI number followed by the ID number. Do not enter a space, hyphen, or other separator between the qualifier and number.Box Number: 33 - Billing Provider Info & Phone NumberWhere
this populates from: Defaults from Business Information -or- If alternate pay to info is selected in My Account/Billing Information, will pull from there.Description: Box 33 is used to indicate the billing providers or suppliers billing name, address, ZIP code, and phone number and is the billing office location and telephone number of the provider or
supplier. Enter the providers or suppliers billing name, address, ZIP code, and phone number. The phone number is to be entered in the area to the right of the field title. Enter the name and address information in the following format: 1st Line Name 2nd Line Address 3rd Line City, State and ZIP Code Item 33 identifies the provider that is requesting
to be paid for the services rendered and should always be completed. Do not use punctuation (i.e., commas, periods) or other symbols in the address (e.g., 123 N Main Street 101 instead of 123 N. Main Street, #101). Enter a space between town name and state code; do not include a comma. Report a 9-digit ZIP code, including the hyphen. Do not use
a hyphen or space as a separator within the telephone number.Box Number: 33a - Billing Information > Billing NPIWhere this populates from: Clinic Settings > Clinic Staff > Details-or- My Account if Use this NPI... is turned on.If this is turned off for the practitioner account page, this populates from Clinic Settings > Billing information.If both are
empty, 33a remains empty.Description: Indicates the HIPAA National Provider Identifier number. Enter the NPI number of the billing provider in 33a.Box Number: 33bWhere this populates from: Billing Info > Billing Preferences > Group IDDescription: Indicates the payer-assigned unique identifier of the professional. Enjoy sharper detail, more
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ondemand.Watch Now Posted on: Dec 12, 2023 | 3 mins | Written by: HDFC ERGO Team Health insurance helps cover the cost of medical treatment and reduces the stress associated with unexpected medical bills. Whether it is an emergency or a planned procedure, you can get cashless treatment at a network hospital or apply for reimbursement if
you are treated at a non-network hospital. However, to ensure your claim is processed quickly and without delay, it is important to fill out the claim form correctly. The claim filing process involves filling out the health insurance claim form and submitting the required documents. Read on to learn how to fill health insurance claim form correctly.
Types of Health Insurance ClaimsThere are two categories of health insurance claims cashless and reimbursement. 1. Cashless claim: If you opt for a medical procedure at a network hospital of your insurance provider, you can file a cashless claim with them. In this case, the insurance company will settle your medical bills directly with the healthcare
establishment, so you will not have to pay the same from your pocket. 2. Reimbursement claim: If you choose a non-network hospital, you need to pay the bills from your pocket and then claim reimbursement for the expenses. Before you file a cashless or reimbursement claim, you must notify the insurance provider about the same. You must also fill
out the claim form correctly and submit it at the TPA desk of the hospital for verification. If you are filing a reimbursement claim, you must attach original bills and receipts with the claim form. The insurer will verify the same before reimbursing your healthcare expenses. How to Fill Out a Health Insurance Claim Form? Whether you choose a network
or non-network hospital for a medical procedure, you must fill out the claim form of your insurance provider. You can download the form online or obtain it from the insurance company or TPA. Once you have the claim form, heres how you must fill it out: 1. A health insurance claim form has two sections, i.e., Part A and Part B. While Part A is to be
filled out by the policyholder, Part B is for the hospital. 2. If you are thinking about how to fill claim form Part A, start by entering your name, address, policy number, email ID, phone number, medical history, details of your hospitalisation, etc. 3. Enter all the details correctly and review the form minutely before you submit it to the insurance
company. Any incorrect or incomplete information can lead to a health insurance claim rejection. 4. If you are filing a cashless claim, you must submit your cashless card along with the duly filled claim form at the hospitals TPA desk. The insurer will verify your claim before settling your bills with the hospital. 5. For a reimbursement claim, you must
submit the claim form, discharge summary, and the original bills and receipts to the insurance provider. If you are wondering how to fill reimbursement claim form, remember to provide accurate details and attach all necessary documents, such as your medical certificate, ID proof, and any other papers related to the claim. 6. Collect everything,
arrange them date-wise and submit them to the insurance provider. Since you have to submit original documents, remember to take their photocopies for your records. ConclusionMake sure you fill out the health insurance claim form correctly to avoid rejection of your claim. Also, remember to inform the insurance company about your medical
procedure at least 48 to 72 hours in advance. For medical emergencies, you must inform the insurer within 24 hours of hospitalisation. Submit all bills and receipts with the claim form so the insurer can verify them and reimburse the expenses. FAQs1. How soon should I file my claim? It is best to file your claim as soon as possible to ensure smooth
processing. The general timelines for filing cashless and reimbursement claims are: Cashless claims: Planned hospitalisation: Inform the insurer or third-party administrator (TPA) at least 48 to 72 hours before admission, or as mentioned in your policy terms and conditions. Emergency hospitalisation: You must notify them within 24 hours of
admission. Reimbursement claims: If you choose a non-network hospital, file your reimbursement claim within 7 to 30 days from the date of discharge, depending on your insurers policy. 2. What if I forget to inform the insurer within 24 hours? If you dont inform the insurer or TPA within 24 hours or the stipulated time of an emergency
hospitalisation, they may reject your cashless claim. However, you can still apply for a reimbursement claim after discharge by submitting all the required documents like bills, prescriptions and the discharge summary. 3. Is pre-authorisation needed for every cashless claim? Yes, you need pre-authorisation for every cashless claim. If it is a planned
hospitalisation, send the request 48 to 72 hours before getting admitted. In case of a medical emergency, inform the insurer or TPA within 24 hours of hospitalisation. Disclaimer: The above information is for illustrative purposes only. For more details, please refer to the policy wordings and prospectus before concluding the sales. RELATED ARTICLES
How to Claim Critical Illness Insurance for Sudden Illnesses Do You Know About The New Health Insurance Claims Norms Introduced In 2024? What is Claim Rejection and Claim Repudiation in Health Insurance? How Does a No-Claim Bonus Work in Health Insurance? How to Fill a Health Insurance Claim Form? 0 0 Health insurance safeguards you
from financial woes in times of medical emergencies covering all your expenses as outlined in your policy. Investing in a comprehensive health insurance plan offers various benefits, including cashless hospitalization, coverage for outpatient department (OPD) expenses, daily cash allowances, diagnostic costs, and more. You can also opt for add-ons or
riders to make your plan an all-encompassing one including all family members in the policy.We at HDFC ERGO are committed to making your life easier with our services. To ensure you get the right support we ensure seamless settlement of claims by settling one claim every minute*. Our range of health insurance plans has brought smiles to 1.4
crore happy customers, with the numbers growing daily. With our my:Optima Secure plan, you get 4X coverage at no extra cost. Additionally, our health insurance policies come with various benefits including cashless hospitalization, tax savings under Section 80D of the Income Tax Act, and a no-claim bonus. So, take a step towards securing the
future of your loved ones by prioritizing their health and well-being. No Cost Installment Available*”™ We've taken protection to the next level by introducing new add-ons that offer extra coverage you've always wanted. Our newly launched my:Optima Secure plan offers 4X health coverage at no additional cost, which means you actually get 4X health
cover at the cost of your preferred sum insured.Buy Now Know more Just Launched Always wanted a health insurance plan that gives essential coverage at affordable premiums with an adequate base sum insured? Well, we heard you. Introducing Optima Lite with a base sum insured of 5 lacs or 7.5 lacs. So you dont have to compromise on securing
your health.Buy Now Know more Just Launched Along with 4X health coverage, this plan provides a global cover which includes coverage for hospitalisation expenses within India and coverage only for emergency medical treatments overseas. This health insurance plan ensures you dont have to invest in medical insurance separately while travelling
overseas.Buy Now Know more Your life revolves around your family. Then, why leave their health unprotected? Get a health insurance plan from us and make the most out of our special benefits like unlimited day care treatments and sum insured restore benefits which will cater every members medical needs.View Plans Know more While you plan
your finances, dont miss out on buying a health insurance plan for yourself.Get benefits like fitness discount and sum insured rebound. Our health insurance plans for individuals will take care of medical expenses without impacting the savings.View Plans Know more Your parents care for you always. Its your turn to take utmost care of their health by
securing their growing medical expenses. Our health insurance plan for parents offer lifelong renewability & AYUSH benefits to cater their growing medical needs.View Plans Know more Its that phase of life when you must leave aside worries and stay worry free. Then, why let the stresses of paying medical bills bother you? Get yourself a health
insurance plan that applies no room rent sub limits and is lifelong renewable.View Plans Know more If you already have a corporate health insurance, then it covers you only during your work tenure and goes out of action once you resign. Hence, get yourself covered under our comprehensive health cover for employees and leave aside financial
worries arising due to medical expenses.View Plans Know more It is no secret that diabetics need special medical attention! While you track your blood sugar count and tackle Diabetes, let us offload hospitalisation worries with Energy health insurance plan.View Plans Know more No doubt you are a super women with super powers, but you too need
medical care at some point of time in life. With my:health Women Suraksha stay secured against life threatening illnesses & stay financially strong.View Plans Know more No Cost Installment Available*”™ Just Launched Just Launched my:health Medisure Super Top-up Critical Illness Insurance 4X Coverage* Wider Pre & Post Hospitalisation Free
preventive health-check upsSecure Benefit: Get 2X coverage from Day 1. Restore Benefit: 100% restores your base coverage No Cost Installment*” Option: Credit and Debit card holders can now opt for the No cost installment*” optionAggregate Deductible: You can enjoy up to 50% discount every year by choosing to pay a little bit more. You also
have the super power to waive your opted deductible at renewal post completion of 5 years under this Policy@ EXPLORE MORE Watch a Video to understand this better Preferred Choice of Base Sum Insured 5 Lac or 7.5 Lac All Day Care Procedures Covered Unlimited Automatic RestoreBase Sum Insured Option: Choose a 5 Lac or 7.5 Lac plan
according to your needsAutomatic Restore: Instant addition of 100% of Base SI upon complete or partial utilization of Sum InsuredCumulative Bonus: Bonus of 10% of Base SI every year max. upto 100% once you renew the PolicyProtect Benefit: Coverage for 68 Non-Medical expenses listed by IRDAIEXPLORE MORE Watch a Video to understand this
better 4X Coverage for claims made in india Overseas Treatment Covered Free preventive health-check upsGlobal Health cover: comprehensive health cover for medical expenses in India as well as overseas medical treatment expenses Plus Benefit: 100% increase in coverage after 2 years No Cost Installment*” Option: Credit and Debit card holders
can now opt for the No cost installment*”~ optionProtect Benefit: Zero deductions on listed non-medical expensesEXPLORE MORE Watch a Video to understand this better 16000+ Cashless Network Cashless Claims Settled in 38 Mins*~ Free preventive health-check ups100% Restored Benefit: Get 100% of your cover restored instantly after your first
claim.2X Multiplier Benefit: Get up to 100% additional policy cover as no claim bonus.Complete coverage 60 days prior & 180 days post your hospitalization. This ensures better planning of your hospitalization needs. Higher cover at low premium Compliments existing health insurance No premium hike post 61 yearsWorks on Aggregate Deductible:
This health plan comes in action once your all round total claim amount reaches the aggregate deductible in a year, its not necessary for a single claim to meet the deductible unlike other top-up plans.No health checkups upto Age 55 : Its better to be safe than sorry! Secure your health when you are young to avoid medical tests.Pay less, Get more:
Opt for a long-term policy of 2 years and get a 5% discount. Covers upto 15 Critical illnesses Lumpsum payouts Affordable premiumsNo medical Check-ups: No medical check-ups up to the age of 45 years.Lifetime Renewability: The policy can be renewed for a lifetime period.Free Look Period: We provide a free look period of 30 days starting from the
date of receipt of the policy document. Cancer cover for all stages Lumpsum Payouts Lifelong renewableMy Care Benefit: From chemotherapy to stem cell transplantation, iCan offers complete cover for conventional and advanced treatments.CritiCare Benefits: Get an additional 60% of the sum insured, as a lump sum payment if cancer is detected of
specified severity.Follow-Up Care: Cancer treatments often have side-effects. Follow up care benefit gives you reimbursement up to 3,000 twice a year. Here is some data to help you understand why staying healthy should be a conscious choice Chronic diseases contribute to an estimated 53% of deaths and 44% of disability-adjusted life-years lost.
Cardiovascular diseases and diabetes are highly prevalent in urban areas. Tobacco-related cancers account for a large proportion of all cancers.Read More The estimated number of cases of cancer in India for the year 2022 was found to be 14,61,427. In India, one in nine people are likely to develop cancer in his/her lifetime. Lung and breast cancers
are the leading sites of cancer in males and females, respectively. The incidence of cancer cases is estimated to increase by 12.8 per cent in 2025 as compared to 2020. Read More According to 2024 Global Hepatitis Report by the World Health Organization (WHO) India accounted for a significant 11.6 per cent of the world's hepatitis cases in 2022,
with 29.8 million hepatitis B and 5.5 million hepatitis C cases. Half the burden of chronic hepatitis B and C infection is among people 3054 years old and men account for 58 per cent of all cases, the report noted.Read More India is considered to be the global diabetes capital with an estimated 77 million people above the age of 18 years suffering from
diabetes (type 2) and nearly 25 million are prediabetics. In India, the median average annual direct and indirect costs associated with diabetes care were estimated at 25,391 and 4,970, respectively. Extrapolating from the Indian population, the annual cost of diabetes was found be USD 31.9 billion in 2010.Read More In 2021, pneumonia was the
leading cause of death from communicable diseases in India, killing over 14,000 people. Acute respiratory infections were the second leading cause of death, killing over 9,000 people.Read More India has one of the highest burdens of cardiovascular disease (CVD) worldwide. The annual number of deaths from CVD in India is projected to rise from
2.26 million (1990) to 4.77 million (2020). Coronary heart disease prevalence rates in India have been estimated over the past several decades and have ranged from 1.6% to 7.4% in rural populations and from 1% to 13.2% in urban populations.Read More Key Features Benefits Cashless Hospital Network 15000+ across India Tax Savings Upto 1
lac**** Renewal Benefit Free Health Check-up within 60 Days of Renewal Claim Settlement Rate 2 Claims/Minute* Claim Approval Within 38*~ Minutes Coverage Hospitalization Expenses, Day Care Treatments, Home Treatments, AYUSH Treatment, Organ Donor Expenses Pre & Post Hospitalization Covers Expenses upto 60 days of admission & 180
days post discharge Just like every other health insurance plan, we too cover your hospitalization expenses such as room rent, ICU charges, investigations, surgery, doctor consultations etc. when hospitalised either due to an accident or for a planned surgery. We believe mental healthcare is just as important as physical illness or injury. Our health
insurance plans are designed in a way to cover hospitalization expenses incurred for treating mental illnesses. Our medical insurance policies include all your pre and post hospitalisation expenses up to 60 days of admission and post-discharge expenses till 180 days Medical advancements help in wrapping up important surgeries and treatments in
less than 24 hours, and guess what? We have included daycare treatments in our health insurance plans to cover you for that as well. In case of non-availability of hospital beds, if the doctor approves treatment at home our medical insurance policy covers you for that as well. So that, you get medical treatment right in the comfort of your home. This
benefit acts like a magical backup, which recharges your exhausted health cover up to the sum insured even after a claim. This unique feature ensure uninterrupted medical coverage at the time of need. Organ donation is a noble cause and at times this could be a life-saving surgery. This is why our health insurance plans cover the medical and
surgical expenses of the organ donor while harvesting a major organ from the donors body. If you stay in a hospital for more than 10 days at a stretch, then we pay for other financial losses that might have happened due to your absence at home. This feature in our plans ensure you can take care of your other expenses even during your
hospitalization. If you are a believer in alternate therapies like Ayurveda, Unani, Siddha, and Homeopathy let your belief system stay intact as we cover hospitalization expenses for AYUSH treatment as well in our health insurance plans. Health insurance policies often offer a complimentary annual health checkup to help you stay fit and active and
prevent illnesses. These checkups include multiple diagnostic tests, such as liver function tests, lipid profiles, and tests for vitamin deficiencies, among others. Once you get yourself secured with us, there is no looking back. Our health insurance plans continue to secure your medical expenses for your entire lifetime on break-free renewals. A
multiplier benefit equal to 50% of the base sum insured from the expiring policy will be provided at renewal, regardless of any claims made during the policy term. This benefit can accumulate up to a maximum of 100% of the base sum insured.The above mentioned coverage may not be available in some of our Health plans. Please read the policy
wordings, brochure and prospectus to know more about our health insurance plans. Adventures can give you an adrenaline rush, but when coupled with accidents, it can be hazardous. Our health insurance plan does not cover accidents encountered while participating in adventure sports. If you ever end up causing injury to your precious self, then
unfortunately our health insurance plan will not cover for self imposed injuries. War can be disastrous and unfortunate. However, our health insurance plan does not cover any claim that is caused due to wars. Our health insurance plan does not cover accidental injury while you are participating in defence (Army/Navy/Air Force) operations.We do
understand the criticality of your disease. However, our health insurance plan does not cover venereal or sexually transmitted diseases. Treatment of obesity or cosmetic surgery is not eligible for coverage under your health insurance plan.This benefit acts like a magical backup, which recharges your exhausted health cover to treat the next
hospitalization of a new illness or injury.If your Doctor recommends, you can get yourself treated at home and avail cashless medical facilities with utmost ease. This service is now available in 16 cities.Just like every other health insurance plan, we cover you for your medical hospitalization due to illnesses and injuries seamlessly.It means all your pre-
hospitalization expenses upto 60 days of admission and post-discharge expenses till 180 days get covered, like the costs for diagnostics, consultations, etc.Medical advancements help in wrapping up important surgeries and treatments in less than 24 hours, and guess what? We cover you for that as well.Let your belief in alternate therapies like
Ayurveda, Unani, Siddha, and Homeopathy stay intact as we cover hospitalization expenses for AYUSH treatment as well.Organ donation is a noble cause and we cover the medical and surgical expenses of the organ donor while harvesting a major organ from the donors body.If you stay in a hospital for more than 10 days at a stretch, then we pay for
other financial losses that might have happened due to your absence at home. It helps to take care of other expenses during your hospitalization.We believe mental healthcare is just as important as hospitalization due to physical illness or injury; hence, we cover hospitalization expenses incurred for treating mental illnesses.Get a free health check-up
within 60 days of renewing your policy with us.Once you get yourself secured with, our health insurance plan there is no looking back. Our health plan continues to secure your medical expenses for your entire lifetime on break free renewals. Jaslok Medical CentreAddressC-1/15A Yamuna Vihar, Pincode-110053Roopali MedicalCentre Private
LimitedAddressC-1/15A Yamuna Vihar, Pincode-110053]Jaslok Medical CentreAddressC-1/15A Yamuna Vihar, Pincode-110053 The sole purpose of buying a health insurance plan is to get financial support at the time of medical emergency. Hence, it is important to read the below steps to know how Health Insurance claims process works differently for
cashless claims and reimbursement claim requests. 1 Fill up the pre-auth form at the network hospital for cashless approval 2 Once hospital intimates us, we send you the status update 3 Hospitalisation can be done on the basis of pre-auth approval 4 At the time of discharge, we settle the claim directly with hospital 1 You need to pay the bills initially
and preserve the original invoices 2 Post hospital discharge send us all your invoices and treatment documents 3 We verify your claim related invoices and treatment documents 4 We send the approved claim amount to your bank account. Below are the documents that you need to keep handy when making a claim against your health insurance policy.
However, do read the policy terms and conditions carefully, in order to avoid missing out any important document.The claim form with your signature and valid identity proof.Prescription of the doctor stating hospitalization, diagnostic tests and medicines.Original Hospital , diagnostic , doctors and medicine bills along with receipts.Discharge
summary, case papers , investigation reports.Police FIR/medico legal case report (MLC) or post-mortem report if applicable .Proof of named Bank Account like Cheque copy/Passbook/Bank statement A health insurance plan not only covers your medical expenses but also offers tax benefits so that you can save upto 1 lac*** under Section 80D of
Income Tax Act 1961. It plays an important role in planning your finances. By getting yourself a health insurance plan, you can get a deduction of up to 25,000 per budgetary year for medical insurance premium under Section 80D of Income Tax Act 1961. If you are paying the medical insurance premium for guardians, then you can also claim an
additional deduction of up to 25,000 every budgetary year. If your parents or either of them is a senior citizen, then this limit can go up to 50,000. You can also claim tax benefits on preventive health check-ups annually under Section 80D of the Income Tax Act. You can claim up to 5,000 every budgetary year as expenses incurred for preventive
health check-ups, while filing your Income Tax Return.Please note that the above-mentioned benefits are as per the current tax laws prevailing in the country. Your tax benefits may change subject to tax laws. It is advisable to reconfirm the same with your tax consultant. This is independent of your health insurance premium value. It is always
advisable to buy a good health insurance plan as early as possible because health emergencies can happen anytime, without any prior notice. The following points will make it even clearer, why it is important to buy a health insurance policy at an early age: Premium is comparatively lower when you get a health policy at a young age. This reason for it
is that, for the insurance company, the lower the age, the lesser is the health risk associated. In certain cases, you might be excused from the mandatory health check-ups that people of a certain age must undergo to obtain health insurance.Health insurance policies have waiting periods for a few health conditions. If you purchase a mediclaim policy
when youre young, you complete them sooner. Scenario 1 Dependency On Employers Health Insurance planMost of us consider employee health insurance as a secured cover for taking care of medical expenses. However, you must know that employer health insurance covers you only during your job tenure. Once you leave the company or switch
jobs, you lose your health insurance benefits. Some companies do not offer health cover during initial probation period. Even if you have a valid corporate health cover it may offer a lower sum insured, lack modern medical coverage and may also ask you to co-pay for claims. Hence, always have a personal health insurance plan for yourself and your
family to be double sure.Scenario 2 Unaware Of The Benefits Of Including Health Insurance in Financial PlanningJust like you pay EMIs, credit card bills, invest in mutual funds or pay premium for life insurance plans to ensure a sound financial planning, similarly you need to buy a health insurance to secure your savings in the longer run. Because,
most of us do not realize the importance of health insurance until something fatal hits us or people around us. Lack of awareness may hamper your savings if an unexpected medical expense comes up.Scenario 3 Thinking a Higher Sum Insured Might Not Be Necessarylt is important to understand that you need a higher sum insured if you reside in a
metro city where medical treatment expenses are high. If a single hospitalization in a year is enough to exhaust your sum insured then you should consider a higher sum insured. Just buying a health insurance wont help in the long run. Getting a sum insured thats enough to cover your medical expenses is equally important. Also, if you are covering
more family members then consider taking a health insurance policy with a sum insured above 10 lacs.Scenario 4 Miscalculating The Benefits of Premium Vs CoverageDont just look at the premium and go back thinking if you should buy this health insurance plan. Looking at the list of coverage and benefits before buying a health insurance plan is
important and should not be overlooked. If you think of buying a health insurance plan with a low premium then there are high chances that you may miss out critical coverage. In future, you may feel that certain coverage is important but your policy doesnt cover it. Scout for a health insurance plan that is not just pocket friendly but also value for
money.Scenario 5 Buying Health insurance Only To Save TaxMany of us buy health insurance just to save tax under section 80 D. A health insurance plan helps you save tax upto 1 lac**** However, there is a lot more beyond saving taxes. Get yourself a health insurance plan that helps you during critical times and helps in saving finances in the long
run. You must also get a health insurance plan for your parents, spouse, and kids to ensure complete financial security.Scenario 6 Undermining the importance of buying a health insurance at a younger agelf you are young, hale and hearty you should buy a health insurance plan now to get lower premiums. Secondly, if you do not make claims post
buying a health insurance cover you get cumulative bonus, which gives you hike in sum insured without charging extra premium as a reward for staying fit. Thirdly, every health policy comes in with waiting period, so if you buy health insurance while you are young your waiting period gets over during the initial years. Later, if you have any disease
your policy covers you seamlessly. Lastly, looking at the pandemic situation its not wrong to say that any one at any point of time may need hospitalisation if not due to ailment may be due to an accidental injury; hence its important to stay prepared. Every time you look for a health insurance plan, you wonder which is the best health insurance plan?
How to choose the best health plan online? What coverage should it have? To answer all your queries lets read more to decode the hacks to get the right health insurance plan.If you are looking to insure yourself consider a health insurance plan with a sum insured ranging between 7 lacs to 10 lacs. For a family a policy the sum insured could range
between 8 to 15 lakhs on floater basis. Remember, your health insurance plan should be adequate to cover for more than one hospitalisation that may happen in a year.Health insurance premiums are quite affordable. So when you chose a plan, dont make a hasty decision of paying low premiums for a smaller sum insured and then co-pay your hospital
bills later. You might end up paying hefty amount for your medical bills. Instead, work on a co-payment clause thats easy on your pocket. Always check if the insurance company has a wide list of network hospitals included in your health insurance plan. Also check, if the nearest hospital or medical facility is listed by the insurance company, so it will
help you avail cashless treatment. At HDFC ERGO, we have a huge network of 15,000+ Cashless Health care centers.Usually your medical expenses depend upon your room type and disease. It is recommended to buy a health insurance plan that does not have sub-limits on hospital room rent so that you can choose the hospital room as per your
comfort. Most of our policies also dont imply disease sublimit; this is also an important factor one must keep in mind.Your health insurance plan does not come into action while you are waiting period is not completed. Always check health insurance policies with lower waiting periods for pre-existing ailments and maternity cover benefits before
buying a health insurance plan online.Always choose a health insurance company that has a good reputation in the market. You must also look at the customer base and claim paying ability to know if the brand will honor the claims that you may make in future. Choosing a health insurance plan is a commitment of both policyholder and insurer, so
take a decision calmly. With the development in technology, treatments and the availability of more effective medicines the cost of healthcare has steeply increased.All this increase ends up being a burden on your savings, making healthcare unaffordable for many. This is where HDFC ERGOs health insurance policies come into play, as they take care
of the hospitalization and treatment charges, leaving the consumer free of financial woes.Scenario 1 You are a young, healthy youth in the late 20s or early 30s with a few financial responsibilities.With the development in technology, treatments and the availability of more effective medicines the cost of healthcare has steeply increased. All this
increase ends up being a burden for the consumers, making healthcare unaffordable for many. This is where HDFC ERGOs health insurance policies come into play, as they take care of the hospitalization and treatment charges, leaving the consumer free of financial woes. Get yourself a health insurance plan now. This affordable health insurance
plan will offer you a large coverage. It will help you save tax as well. In future, you can add your spouse and child to this plan as well. Acts as a magical tool to bring back the exhausted sum insured in your health insurance policy, covering future hospitalization that may happen in the same policy period. Therefore, you always hold double protection
although you pay only for a single sum insured.If you do not make any claim, your sum insured in your health insurance policy is increased by 10% as a bonus or reward upto a maximum of 100%.This is our most-recommended plan for all those who are just willing to buy their first insurance plan.No hospital room rent restrictionCashless claims
approvedwithin 38*~ minutesScenario 2 You already have a corporate health cover & do not wish to spend too much on health insurance.Even though your employer covers you, the freedom to customize it as per your growing need does not remain in your hands; additionally, if you ever quit your job then your health insurance cover ends. So, why
risk your health cover with an employer, when you can easily get one for yourself. However, if you still feel that your employers health cover or existing health cover suits well then there is no harm in topping it up for a higher cover at a much lower premium. This health insurance plan gives you a much higher cover at a lower premium. It acts as a
top-up to your existing health insurance. Hospitalisation coversDay care proceduresHigh cover at a lower premiumScenario 3 You have a family to take care of and want to cover your spouse & kids under a single health insurance policy.If you are looking for a family health insurance plan then go for our best selling health insurance plan that aims at
securing your familys growing medical needs. This health insurance plan will take care of your familys growing medical needs by offering sum insured restoration benefit, so that you never run out of health cover. It also gives 2x multiplier benefit to get a increase in sum insured when you do not make claims.12,000+ Cashless network hospitalsPre-
hospitalisation for 60 days and post hospitalisation upto 180 days remains coveredTax savings up to 1 lac****Scenario 4 You are looking for a comprehensive health insurance plan to secure your parentsWe understand that you are deeply concerned about your parents growing age and willing to cover them. Its important to gift then a health insurance
plan, so that they dont dig into their lifelong savings for paying hospital bills. for your parents who may or may not be senior citizens. It is a simple no-fuss health insurance plan that gives all basic coverage at a premium that is pocket friendly. No room rent restrictionsHome health care for convenienceAlternative treatments covered like Ayurveda,
Homeopathy, Unani and SiddhaNearly 12,000+ Cashless hospitalsHospitalisation, pre and post hospitalization expenses covered.Scenario 5 You are a confident and independent woman willing looking for a health insurance policy to secure your health.For all those confident and self-reliant women, to take care of women related 41 critical illnesses,
cardiac ailments, and cancer cover. Offers lump-sum benefitContinue even after a minor illness claim is paid.Includes almost all women-related ailments.Extremely affordable premium.Optional covers like loss of Job, Pregnancy & New-born baby complications, and Post-diagnosis support.Scenario 6 Your family has a Critical Illness History so you
need a health insurance policy for critical cover.A single critical illness is enough to put a pause to your life be it due to the long treatment course or the financial requirements. We help you cover the medical expenses so that you focus only on recovering. for securing 15 major critical illnesses, which include stroke, cancer, kidney-liver failure, and
many more.Lump Sum payment in a single transactionHelps in supporting in case of job lossYou can pay for your debts and fulfill financial responsibilities.Tax benefits. When considering purchasing a health insurance plan, common questions that may arise include eligibility, required medical tests, and age criteria. However, these days it is easy to
check your eligibility for a specific health insurance plan in India before making a purchase online.At the time of buying a mediclaim policy, it's essential to disclose any prior health conditions you may have. This includes serious diseases, birth defects, surgeries, or cancers, not just common ailments like flu or headaches. Failing to do so may result in
certain conditions being permanently excluded from coverage, or covered with a waiting period or additional premium. It's important to inform your insurance company about any pre-existing conditions to ensure full coverage. Key factors that decide your eligibility for buying Health Insurance PlansWhile buying a mediclaim policy, you have to be
honest enough to declare all your pre-existing illnesses. These illnesses need not be your usual fever, flu, or headaches. However, if in past you have ever been diagnosed with any disease, birth defects, undergone surgery, or cancer of any severity it is important to inform your medical insurance company. Because, many ailments are listed under
permanentexclusion, few are covered with a waiting period and few others are covered by charging additional premium with a waiting period. Also Read : Should you disclose pre-existing illnesses while buying health insurance? If you are above 18 years of age, you can easily buy a health insurance plan for yourself. We also cover newborn babies but
the parent needs to have a mediclaim insurance policy with us. If you are a senior citizen,you can get yourself insured upto the age of 65 years. Also Read : Is there an Age Limit for Availing of Health Insurance ? Gone are the days when you wait for someone to come and explain the policy to make a buying decision. With digital trends taking over the
world, buying a health insurance plan from anywhere across the globe helps you in saving time, energy, and effort. You do not have to pay premiums in cash or cheque for your health insurance plan! Go Digital! Simply use your credit/debit card or net banking services to make payments online through multiple secured payment modes. You can
instantly calculate the premium, add or remove members, customize plans, and check coverage online at your fingertips to buy a health insurance plan online. You no longer have to wait for the physical health insurance policy documents. Your policy PDF copy comes right into your mailbox as soon as you pay the premium online and you get your
policy within a few seconds. Get access to your policy documents, brochure etc in our my:health services mobile application. Download our wellness application to book online consultations, monitor your calorie intake and keep a track on your BMI as well. The easiest and most convenient way of buying the best health insurance is to purchase it
online. Heres how you can buy a HDFC ERGO health insurance policy online: Visit the health insurance page of HDFC ERGO.Right on top, you will find the form. Type your basic information such as contact details, the type of plan etc. Then click on view plans buttonOnce you have seen the plans, customize your policy by choosing the preferred sum
insured, policy terms, and other information.Choose an online payment mode and make the payment through our secure payment gateway. Mediclaim policy is a type of insurance that provides financial coverage for medical expenses. The policy covers all hospitalization expenses, including room charges, medication, and other treatment costs.
However, the sum insured in a mediclaim policy is limited compared to a health insurance plan. The amount of coverage you receive depends on the sum insured that you have selected, which is usually up to a few lakhs. During a claim, in some cases, you may need to provide proof of expenses, such as hospital bills or discharge reports, to be
reimbursed.Mediclaim insurance provides financial coverage for healthcare expenses, similar to health insurance. However, under a mediclaim policy, you typically need to be hospitalized to receive the benefits. This means that you may not be able to receive home healthcare benefits without actually being hospitalized. Additionally, mediclaim
policies usually do not offer the flexibility to add family members, increase the sum insured, or add additional benefits as needed. Overall, mediclaim policies are generally not customizable. Also Read: Know the Difference between Health Insurance Policy and Mediclaim. There are a plethora of options available in the market when it comes to buying
health insurance but choosing the best health insurance plan in India is in your hands. Have you ever wondered why some insurance plans have a higher premium and low coverages, while some might have high coverages but a low claim settlement ratio? Finding a health insurance plan which offers comprehensive coverages and affordable premium
is ideal, you can find them by researching online. Best health insurance plan must consist of the following:When you get admitted in a network hospital your claim process becomes very simple and quick. Always check if the insurance company has a wide list of network hospitals. If the nearest hospital or medical facility is listed by the insurance
company it will help you avail cashless treatment.Having Cashless Health Insurance is must in India in todays time. You do not have to worry about the bill as the hospital and the insurance company settles it internally.What is the use of having a health insurance policy when the claims continuously keep getting rejected? Hence the best health
insurance plan in India must have a good claim settlement ratio.Having a range of sum insured amount to choose from can be helpful as you can select the amount based on your requirement. Your sum insured amount must able to support you at the time of a medical emergency.Best health insurance policy is highly recommended by all the
customers as they give remarkable reviews and ratings to the health insurance plan. You must go through the ratings and reviews available online for better decision making. Medical science has advanced a lot and there are various diseases can be treated at home. Hence, the best health insurance plan in India must consist of home care facility as
the medical expenses incurred at home are also covered. A dependent in health insurance is a person who is related to the policyholder. Any family member whom the insured wants to provide health insurance coverage to in their health insurance plan can be included as a dependent. In simple terms, a dependent is a person who is a family member
or relative of an insured person.Having This component of health insurance can reduce your policy premium, but it also means that you have to pay a fixed sum at the time of insurance claim. So, do read the policy documents for the deductible clause and choose the one that does not include it, until you are ready to bear the treatment cost.The sum
insured is the maximum amount an insurance company will pay for the covered medical expenses of the insured individual within a policy period. For example, if your sum insured is 5 lakh, the insurer will cover hospital bills and treatments up to 5 lakh. If your bills go beyond that, you will have to pay the extra amount yourself. A few health insurance
plans have a co-payment or co-pay clause. It is a fixed percentage of a sum the policyholder has to pay to the insurance company before receiving the healthcare service. It is mentioned pre-decided and mentioned in the policy wordings, e.g. if someone agrees to pay 20% co-pay at the time of claim, for each time a medical service is availed, they have
to pay that sum.Critical illnesses medical conditions refer to life-threatening medical diseases like cancer, kidney failure, and cardiovascular diseases. There are separate health insurance plans that cover these illnesses. They can also be purchased as a rider or add-on cover for the same. Health issues like COPD, hypertension, diabetes, kidney
problems, cardiovascular issues, and other underlying diseases are considered to be risk factors in terms of health insurance. Patients with pre-existing medical conditions as stated above are considered to be at a higher risk and are therefore charged a higher premium. Are you tired of going to multiple people to clear your doubts? What if we tell
you there's a solution that can help you make better decisions in life. Access verified articles and videos on health topics, created by healthcare experts and doctors from around the world. Make healthcare affordable with a range of offers from partner e-pharmacies and diagnostic centres. Connect with verified volunteers who have gone through a
similar medical experience. 4.4/5 Stars Our customers have rated us Customer Executive was professional in communication, knowledgeable & skilled about product policy & website how to queries . Helpful in nature & possess a good attitude. Thank you HDFC ERGO TEAM HDFC ERGO already has Great services, super fast claim process, and full
support. So we are Happy to have multiple HDFC ERGO health insurance Policies. Thanks. I like the HDFC ERGO Service, they always be there and support me and my family , We feel safe and secure With HDFC ERGO Thank you Always The Customer Care Executive Ms. Chandra listened my query and resolved it very well. She also explained many
things about my policy and claim related matters and I really appreciate it. Medical Claim processing is good and speedy. Very thankul to HDFC ERGO team for their excellent response time. HDFC ERGO reimbursement process is very user-friendly. My claims were processed quickly and in 2 days' time. I was also confirmed by the SME once the
claims were processed to check. A professional approach. Thanks to entire team. HDFC ERGO is a Best policy giving company and Help customer as soon as they can. I am very thankful to HDFC ERGO for giving me best service and provide all facilities I want to take a moment to appreciate Jishan Kazi (EMP ID: 19004), Health Insurance Advisor at
HDFC ERGO, for the excellent service he provided. His patience, professionalism, and dedication stood out as he guided me through my health insurance buying journey. Jishan handled my queries with great care, and his ability to address concerns calmly and efficiently was impressive. He truly went above and beyond to ensure a smooth experience.
I believe he is a valuable asset to your team and will continue to excel in his role Arun AHDFC Individual Energy Medical Insurance planDec 2024 I am writing to express my sincere appreciation for the outstanding service provided by Mr. Kamlesh K (Employee ID: 24668) in helping me secure a HDFC Individual Energy Medical Insurance plan for my
mother. Over the past two months, Mr. Kamlesh has demonstrated exceptional professionalism and dedication. He patiently guided me through the entire process, promptly responded to all my queries, and consistently followed up with me. His thorough knowledge of the insurance products and commitment to customer service made process very
straightforward and hassle-free. Please convey my gratitude to Mr. Kamlesh. Thank you for maintaining such high standards of customer service. I would like to express my sincere thanks to Mr Arvind who has been very helpful during my buying journey which helped me to make up my mind to choose HDFC Ergo as my insurance provider. He
explained every minute details with transparency and honesty. It is because of his guidance that helped me make the decision to get a 50 lakh cover for 3 years. We showed immense confidence in his work and I must say, he is a great salesman. I would like to express my heartfelt gratitude to Shehnaz Bano. I really appreciate her help with securing
my policy. Her knowledge about the plan is great. She explained details of the plan with clarity before making the purchase of the policy. I would want her supervisor to recognise her efforts. Keep up the good work. Thank you! I would like to highlight the efforts taken by your team member Puneet Kumar to help me get my insurance. He was on call
with me for 2 hours explaining me the entire process and providing detailed information about the various policies helping me choose the Right one for my needs. He also went out of the way to close the deal on the very call. I think he deserves a pay hike and promotion too. Puneet, keep up the ante and best wishes for your future endeavours. I am
writing to express my sincere appreciation for Mr Mohammed Ali who provided invaluable assistance in securing health insurance coverage for my Family (which is my most important priority) with HDFC ERGO. His expertise and guidance throughout the entire process was truly exceptional. He patiently explained the different plans, answered all my
questions thoroughly, and helped me understand the nuances of each policy. Thanks to his efforts, I am now confident that my family is well-protected with comprehensive HDFC ERGO health insurance coverage. I want to take a moment to appreciate Shubham. I truly admire his in-depth knowledge of the subject and his patience in answering all
questions, even when I repeated some to validate his responses. He is a valuable asset to the HDFC family, and I wish him a bright and successful career ahead. I am extremely thankful to Arvind for his explanation and knowledge regarding various policies offered by HDFC Ergo. His comparison has helped me a lot to chose right policy. As of now I
am proceeding with HDFC Optima Secure. The recent spike in COVID-19 cases in many countries, especially in Asia, has caused a lot of concern among millions of people worldwide. The World Health Organisation (WHO) has promptly jumped into action to monitor the variants causing this spike. Though there are 5 or 6 COVID-19 variants active
currently, the most prominent among them is the Nimbus.READ MORE Published on June 18, 2025A promising Al-based technique called 'Fragle' is claimed to detect even minute traces of tumour DNA in the blood. This game-changing method may bring a lot of precision, accuracy, and affordability in the field of cancer monitoring. It could play a
huge role in understanding patients responses to cancer treatments, and early detection of relapses.READ MORE Published on June 18, 2025The Insurance Regulatory and Development Authority of India (IRDAI) has directed insurance companies to adapt measures to standardise health insurance premium rates following the Pradhan Mantri Jan
Arogya Yojana (PMJAY) scheme model. READ MORE Published on February 28, 2025In a latest report released by the Indian Council of Medical Research (ICMR) and published in Lancet, it was noted that there has been a surge in cancer case in women more than men in the past decade and studies have predicted that the trend will keep rising in the
next two decades. The researchers noted in the study that 3 out of every 5 individual in India succumb to death following a cancer diagnosis. READ MORE Published on February 28, 2025Recently India witnessed the resurgence of bird flu in Maharashtra, Chhattisgarh, Rajasthan, and Andhra Pradesh, following which the Central government has
urged all states to enhance surveillance and biosecurity protocols at poultry farms.READ MORE Published on February 28, 2025According to Union Minister of State for Health Prataprao Jadhav estimated number of deaths due to cervical cancer in India was 34,806 in 2022, 33,938 in 2021, 33,095 in 2020 and 32,246 in 2019. According to the recent
data provided by the Indian Council of Medical Research-National Cancer Registry Programme's (ICMR-NCRP) by the estimated deaths due to cervical cancer cases in the country in 2023 was 35,691.KNOW MORE Published on February 6, 2025 Know more Published on June 24, 2025 EST READ TIME: 3 minutes Know more Published on June 24,
2025 EST READ TIME: 3 minutes Know more Published on June 24, 2025 EST READ TIME: 3 minutes Know more Published on June 24, 2025 EST READ TIME: 3 minutes Know more Published on June 24, 2025 EST READ TIME: 3 minutes Know more Published on June 24, 2025 EST READ TIME: 3 minutes Know more Published on June 24, 2025 EST
READ TIME: 3 minutes 1. Ive health insurance from my company. Should I also purchase a separate health insurance policy?Yes, having a separate individual health insurance plan is important. Your employee health insurance covers medical expenses only till the time you are working in the organization. Once you quit the company, your policy term
ends. Keeping medical inflation in mind, it is important to buy personal health insurance as per your medical needs. Also, a corporate health plan is a common plan designed for all employees.2. How does health insurance portability benefit the policy holders?Health insurance portability helps you to change your health insurance plan without having
to go through a fresh waiting period term. There is a smooth transfer from one insurer to another if your current plan is not sufficient to cover rising medical costs.3. What is meant by pre-existing disease?Network hospitals better known as cashless hospitals have an agreement with your insurance company, because of which you can avail cashless
hospitalisation benefit. On the other hand, if you get treated In a non-network hospital, you have to pay the bills first and later apply for reimbursement claim. So, it is always wise to buy a health insurance company which has a large network hospital tie-up. 4. What does cashless hospitalisation mean in the context of health insurance?Cashless
hospitalisation is a procedure in which the policyholder doesn't have to pay medical expenses out of his pocket in case they are admitted to a hospital or have undergone a surgery. However, there are certain deductibles or non medical expenses at the time of discharge, which are not included in the policy terms, have to be paid at the time of
discharge. 5. What does it mean by pre and post-hospitalisation expenses? In case you have to undergo a surgery, there are certain pre hospitalization expenses such as diagnosis cost, consultations etc Likewise, post the surgery, there could be expenses to monitor the health of the policyholder. These expenses are known as pre and post
hospitalization expenses.6. How many times can medical insurance be claimed?You can file multiple numbers of claims during a policy term, provided it is within the limit of the sum insured. A policyholder can get coverage up to sum insured only.7. Is it possible to buy more than one health insurance policy?Yes, it is possible to buy more than one
medical insurance plan. This entirely depends on an individuals necessity and coverage requirements. 8. Can we claim medical bills in health insurance?Yes, you can claim medical bills in health insurance, as long as it is within the sum insured. For more information, read the policy wording document.9. How long does it take to settle a mediclaim?It
usually takes approx.7 working days in settling a claim if documents are in order.10. How to check medical insurance claim status?You can check your claim status through self-help portals or mobile apps extended by insurers.11. Before buying health insurance, do I need to undertake any medical examination?There may be a few medical tests that
needs to be taken before buying health insurance. For some health insurance policies, the medical tests are required if there are pre existing illnessed or if someone is above 40 years of age.12. What is the process to add my family members to my existing policy?At the time of purchasing or renewal of your health insurance policy, you can add your
family members.13. Can my children be added in my health insurance plan? Also what should be their age?Yes, children can be added to your health insurance plan. They can be added post 90 days of birth up to the age of 21 or 25 years. It varies from company to company, so please go through plan eligibility from the product brochure. 14. Are there
any benefits of buying health insurance at a young age?You are eligible to pay a lower premium and higher benefits. Since the probability of having a pre-existing illness is low, the waiting periods may also not impact you. Apart from that, common diseases such as flu or accidental injuries can happen at any age, so buying a health insurance when you
are young is important.15. Can a person have more than one health insurance policy?Yes. You can always have more than one health insurance plan based on necessity and coverage requirements as every plan works differently and offer varied benefits.16. What does a waiting period in health insurance plans mean?The time span during which you
cannot raise a claim to avail some or all benefits of the health insurance from your insurance provider for a specified illness is known as waiting period. So, basically, you have to wait for a specified amount of time before you request for a claim. 17. What is a Free Look Period?During this free look period, you have the option of canceling your policy
without penalty if you feel your policy is not beneficial. Depending on the insurance company and the plan offered, the free look period can be 10-15 days or even longer. Know more, to know more on free look period.18. What does network/non-network hospitalisation mean?Network hospitals better known as cashless hospitals have an agreement
with your insurance company, because of which you can avail cashless hospitalisation benefit. On the other hand, if you get treated In a non-network hospital, you have to pay the bills first and later apply for reimbursement claim. So, it is always wise to buy a health insurance company which has a large network hospital tie-up. 19. What is meant by
domiciliary hospitalisation?When a policyholder is in a condition that he/she cannot be admitted to a hospital or the treatment is taken at home due to non-availability of room in the hospital, it is known as domiciliary hospitalisation20. What are the benefits under basic hospitalisation?In case of a hospitalization cover we cover expenses like pre and
post hospitalization expenses for your diagnostic tests, consultations and medicine costs. We also cover ICU, Bed charges, medicine cost, nursing charges and Operation theatre expenses widely. 21. Is there a right age to buy health insurance policy?There is no right or wrong age to buy a health insurance policy. However, it is recommended to buy a
health plan early to get lower premiums. Once you turn 18 years old, you can buy a health insurance plan for yourself. Before that a family health insurance plan can cover your healthcare expenses.22. Can Health Insurance be bought by a minor?No, a health insurance policy cannot be purchased by a minor. But they can be covered under the a
family floater health insurance bought by their parents23. If Im admitted to a non-network hospital, what should I do?In case you get admitted at a non-network hospital have to pay the bills from your pocket first and later raise a reimbursement claim from your insurance company. However, your health insurance company will provide reimbursement
only up to the amount of Sum Insured. 24. What does the annual sum insured mean?The annual sum insured is the maximum amount upto which your health insurance will pay for admissible medical expenses during a givenpolicy year. For example, if the annual sum insured is 5 lakh and you are diagnosed with an illness requiring hospitalisation, and
the bill amounts to around 6 lakh, the insurer will only pay 5 lakh.25. Does a waiting period apply if I increase my sum insured at the time of renewal?Yes, waiting periods shall apply afresh to the increased portion of the sum insured [SI] amount. Suppose your original sum insured is 5 lakh, and the plan had a waiting period of 3 year for declared pre-
existing conditions [PED]. After one year, if at renewal you increase the sum insured from 5 lakh to 15 lakh, then for the original SI 5 lakh PED waiting period of 2 years shall apply while for the increased 10 lakh portion afresh PED waiting period of 3 years shall apply.1. Are diagnostic charges like X-ray, MRI or ultrasound covered in Health
Insurance policies?Yes. Most health insurance plans cover diagnostic charges during hospitalization, pre-hospitalization and post discharge as well.2. Does my policy covers diagnostic charges?All HDFC ERGO health insurance plans cover diagnostic charges during hospitalization, pre-hospitalization and post discharge as well.3. Will I get covered for
my pre-existing illnesses?Yes. Once your specified waiting period is over you will get coverage for your pre-existing illnesses. Read this blog, to know more on coverage for pre-existing diseases.4. How can I know if my family is coverd in my helath insurance policy?You need to check your policy document and enroll your family members by
mentioning their name and age to get them covered.5. When a health insurance policy online, will we get a cashless card?Buying online health insurance is no different than purchasing it offline. In fact buying online health insurance is quick and hassle-free. A cashless card via courier/postal services is provided to you. To know more, visit the
company website or dial customer care number. 6. What are the inclusions under hospitalisation expenses?Important medical expenses such as blood investigations, diagnostic charges such as CT scan, MRI, sonography etc. are covered. In certain cases, hospital room rent, bed charges, nursing charges, medicines and doctor visits etc can also be
covered. 7. Are robotic surgery & modern treatments covered unde health insurance plans?Yes. It depends on the policy terms and conditions. However, most health insurance companies offer coverage for modern treatments and robotic surgeries.8. Is COVID-19 treatment covered in my Health Insurance Policy?Yes. Your HDFC ERGO Health
Insurance Policy covers hospitalization expenses for Corona Virus (COVID-19). We will pay the below medical expenses for hospitalization during the policy period for treatment of COVID-19:In the event you are admitted to a hospital for over 24 hours, your medical bills would be covered by us. We would take care of: Stay Charges (Isolation Room /
ICU) Nursing charges Treating Doctor Visit Charges Investigations (Labs/Radiological) Oxygen / Mechanical Ventilation Charges (if required) Blood / Plasma Charges (if required) Physiotherapy (if required) Pharmacy (except non-medicals/consumables) PPE Kit charges (as per government guidelines)9. Is home isolation covered under policy? No,
home isolation is not covered in our Health policies. You can only file a claim for medical treatment undertaken at a hospital or nursing home. The treatment should be on the advice of and be actively managed by a qualified doctor. 10. Will COVID-19 tests be covered under the policyThe testing charges will only be covered in case of hospitalization
for each insured member(s) covered under the policy.11. From what age can I include my children in the plan?You can include your child dependents in a family floater policy after 90 days of their birth and upto the age of 25 years.1. Is it possible to change the nominee during mid-term of a policy?It can be done. An endorsement request needs to be
raised by the policyholder for a change in nominee details.2. In case a policy lapses during hospitalization, what happens in that situation?Does not worry if your policy expires during hospitalization because you get a grace period of 30 days post the policy lapse. However, if you do not renew your policy within the grace period and hospitalization
happens post grace period then you will have to pay for the medical expenses. 3. Is waiting period valid, if my sum insured is increased at the time of renewal?At the start of every health insurance policy, waiting periods are applied. This doesn't change with renewal. However, with every renewal , the waiting period is waived off until you reach a time
when you have no waiting period and the coverage includes most of the treatments. 4. I am a foreigner, but my child is pursuing further studies in India. Can I purchase a health insurance policy for my child?If your child is an Indian citizen, then you can purchase a health insurance policy. If not, you should opt for student travel insurance for your
child.5. Is there any impact on health insurance premiums due to smoking or chewing tobacco?Tobacco users are prone to higher health risks. If tobacco is consumed in any form, the chances of an individual developing some health issue later in life is higher, and this means you might have to claim the treatment cost. So, these individuals are
categorized as high-risk by the insurance company and high premiums are charged from them. 6. What do you mean by cumulative bonus in a health insurance policy?The bonus/ reward that one gets for remaining fit and not filing a claim is known as a cumulative bonus. The cumulative bonus benefit is given in the renewal year by increasing the sum
insured amount only up to a certain year for every claim-free year. This helps you to get a higher Sum Insured without paying anything extra.7. What are health policy discounts?Many companies may offer a family discount if you cover 2 or more family members under a single health plan on an individual sum insured basis. Even long term policy
discounts can be availed on buying health insurance for more than 2-3 years. Some insurers also give fitness discounts on renewals. 8. Can my non-Indian friend buy a health insurance policy if he/she not a citizen but living in India?No. Only Indian citizens can purchase Health insurance plans in the country. 9. Can my health insurance be cancelled?



In that case, can I get my premium back?If a health insurance plan is cancelled within the free look period ,you will get your premiums refunded, after adjusting underwriting cost and pre-acceptance medical costs, etc.1. Is cashless facility available at every network hospital?Yes. There is a pre-decided agreement between your health insurance
company and network hospitals and hence cashless treatment facility is available at every network hospital.2. How many claims are allowed in a year?You can raise a claim as many times you want, until you exhaust your sum insured amount. The best way is to buy plans that help you by restore the sum insured once it gets exhausted. This helps you
register more claims in a year. 3. Are there chances of a request for cashless claim authorization to be rejected/ denied?Yes. A pre-authorization request for cashless claim can be rejected if the policyholder files a claim for an ailment/disease which is either excluded, falls in waiting period or if the sum insured has been already used up. 4. From the
time of an accident, is there a timeline to be followed to file a claim or can it be filed immediately?In case of reimbursement claims, the insurance company needs to be informed within a period of 30 days post discharge.5. What is meant by claim settlement ratio?The percentage of the number of claims that the insurance company paid out during a
financial year out of the total claims incurred is known as claim settlement ratio (CSR). It reflects if the insurer is financially secured enough to pay for its claims.6. Once a claim is filed, what happens to the policy?Your policy period continues as usual, but the amount you claimed for gets deducted from your sum insured. Post renewal of the health
insurance plan, your sum insured again gets back to the amount you had opted for at the time of renewal.7. If I take a costlier health insurance policy, will it facilitate privileged treatment in case of hospitalisation and claim?It depends on the policy terms and conditions. Say, if you have a health cover of 1 crore, this helps you take care of all the
possible medical expenses.8. What is the health insurance claim procedure?A cashless claim request can be raised by contacting the insurance department at the network hospital or your health insurance company. For reimbursement claims, post discharge, you need to send the invoices to your insurance provider.9. What is the time period to file a
medical insurance claim?Within 30 days post-discharge. A claim should be raised with the insurance provider as soon as possible, without any delay. 10. What is medical claim process?Mediclaim process is the modern day reimbursement process, wherein you raise a claim post discharge by submitting original invoices and treatment documents.11.
What is the waiting period for claims under a policy?Waiting periods depend on the policy terms and conditions. There is a waiting period for specific ailments/diseases which could be for 2-4 years.13. If a COVID-19 treatment is taken in non network hospital, is the claim payable? Whenever you get admitted at a non-network hospital you have to pay
the bills first and later claim for reimbursement. HDFC ERGO has nearly 15000+ cashless network.14. What documents are required for making a claim for COVID-19? The following documents required:1. Test reports (from Govt Approved Laboratories ) 2. Bills for the tests underwent3. Discharge summary 4. Hospital bills5. Medicine bills6. All
payment receipts7. Claim formOriginal documents to be submitted1. How do I renew my mediclaim policy?With the development in technology, treatments and the availability of more effective medicines the cost of healthcare has steeply increased. All this increase ends up being a burden for the consumers, making healthcare unaffordable for many.
This is where HDFC ERGOs health insurance policies come into play, as they take care of the hospitalization and treatment charges, leaving the consumer free of financial woes. Get yourself a health insurance plan now. 2. Is my health insurance policy transferable without losing renewal benefits?You can renew health insurance policies within a few
minute. Click here to renew instantly.3. If I increase my sum insured at the time of renewal, does a waiting period apply?Yes. You can port your health insurance policy with any other insurer without impacting your waiting periods.4. Do I get a discount on the renewal of the policy with the same health insurance policy?Waiting period is fixed at the
inception of the policy it is not dependant on the sum insured. Hence, even if you increase your sum insured your waiting period continues until you keep renewing to get away with the waiting period term. 5. If my policy is not renewed in time before expiry date, will it be denied for renewal?Yes. If you have not made claims then you get a cumulative
bonus, which is increase in sum insured without paying for the same. You can also get fitness discount if your health parameters such as BMI, diabetes, Blood pressure is improved. 6. Is it possible to modify my add-on cover while renewing health insurance policy?Possibly yes. If you have not renewed your policy within the grace period then there are
high chances that your policy may lapse.7. Is there a Grace Period for Renewal?Yes. You can add or remove optional/add on cover at the time of renewal. This is not permitted during the policy tenure. Read this blog for more information.8. If I choose to renew my health insurance policy online, how long will it take?Usually it takes not more than 5
minutes but you need to keep details such as your policy number and other information ready.9. If I miss the renewal date of my health insurance policy, what should I do?You get a grace period of 15-30 days to renew your health insurance policy. You need to renew within that period. But, if your grace period is also over then your policy will expire.
Then, you have to buy a new policy with a fresh waiting period and other benefits. BFSI Leadership Awards 2022 - Product Innovator of the Year (Optima Secure) ETBFSI Excellence Awards 2021 FICCI Insurance Industry Awards September 2021 ICAI Awards 2015-16 SKOCH Order-of-Merit Best Customer Experience Award of the Year ICAI Awards
2014-15 CMS Outstanding Affiliate World-Class Service Award 2015 iAAA rating ISO Certification Best Insurance Company in Private Sector - General 2014View all awards
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